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CHAPTER 1. INTRODUCING
WORKSHARE PROTECT

This chapter introduces Workshare Protect, providing an overview of how it works as
well as a summary of the key features and benefits. It includes the following sections:

o What is Workshare Protect?, page 8, introduces Workshare Protect.

o Workshare Protect Functionality, page 8, describes the different areas of
functionality of Protect.

e Accessing Protect Functionality, page 11, describes how to access Protect
functionality after install.

e Licensing, page 14, describes how to license Protect after install.
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WHAT IS WORKSHARE PROTECT?

Workshare Protect helps companies eliminate the risk of accidentally sharing sensitive
data, without interrupting established workflows.

Key features of Workshare Protect include:

e Advanced, interactive metadata cleaning/PDF creation/secure file transfer for
attachments in Outlook

e Comprehensive content risk protection enabling the discovery and removal of
hidden sensitive data as well as visible sensitive data

¢ Options to save and share Office documents to Workshare online
e Access and visibility into online collaborative workspaces directly from Office

o Secure file sharing from all devices and browsers with metadata removal and
end-to-end encryption

e Centralized policy design and enforcement administrator tools
e Centralized user account management and control

o Complete access to Workshare online functionality to share and collaborate on
documents, including setting folder access and permissions, positional
commenting and reviewer communications with presence indicators

e Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Protect can be installed without Microsoft Office integration. In this
case, the metadata removal functionality is only available when sending emails.

WORKSHARE PROTECT FUNCTIONALITY

Workshare Protect provides sophisticated functionality that is convenient and
accessible, enabling users to move smoothly between tasks and work rapidly to
manage changes. Workshare Protect assists you throughout the complete document
lifecycle — from document assembly, review, verification and security.

Workshare Protect may include the Connect product to extend its functionality to
Workshare online.

@ File and Metadata Security

Workshare Protect provides content risk protection through comprehensive cleaning of
metadata and conversion to secure PDF.

Protect enables the discovery and removal of hidden sensitive data as well visible
sensitive data. Hidden sensitive data may include information such as track changes,
author’s name, server names, keywords, routing slips and authoring trails.
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On your Desktop

Protect integrates with Office providing an option to display a comprehensive report of
all the content risk in a document while it is open in Microsoft Word, Excel and
PowerPoint. Content risk is displayed according to its risk level (high, medium, low).
After discovery, users can remove selected metadata.

Protect quickly and securely converts Office documents into PDF or PDF/A files. Users
can access PDF conversion functionality from within Word, Excel and PowerPoint or by
right-clicking closed Office files from the desktop and from within a DMS/CRM or
SharePoint. Additionally users can combine multiple files into a single PDF — a useful
tool at the close of a project or when creating a report that involves documents,
spreadsheets and graphics.

Within Email

Protect can be configured to support the way you work.

Interactive Protect offers options to control documents and secure attachments before
sending email. It simplifies metadata cleaning, avoids email pop-ups, and eliminates
Outlook add-in issues. Protect scans documents as soon as they are added as
attachments to an email. Users are made aware of the risk involved and given the
option to make informed decisions before clicking Send. From the Interactive Protect
panel users can clean metadata from attachments, convert attachments to PDF or
PDF/A, and compress attachments into one zip file. Additionally, users can securely
transfer attachments to a secure location in Workshare online and send recipients a link
to that location.

In other configurations, Protect prevents users from accidentally emailing confidential
information by alerting users before the email is sent when an email or its attachment
breaches security policies. Depending on the actions defined for policy breaches,
emails may be blocked or sensitive data removed. Security policies can specify different
actions when a document is sent internally or externally. For example, it may not be
acceptable for hidden server names and user details to be included in documents sent
externally, but it may be fine to leave those details in documents sent within an
organization. Protect comes with a pre-defined default security profile (collection of
policies).
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® File Share and Sync

Workshare’s online services provide a secure file sharing and online collaboration tool
that enables users to store, share, and collaborate on content. There are several ways
of interacting with the online services offered by Workshare, either online through a web
browser or using special apps. The Workshare desktop app is the app for use on PCs
and it is installed as part of the Protect installation when you select the File Share &
Sync product.

Note: Workshare’s mobile app is an app designed for use on smartphones and tablets
that provides access to documents in Workshare online while on the move.

Users can sync documents safely across all their devices automatically updating
content between Workshare online and their desktop and mobile devices.

With the Groups functionality, users can easily organize and manage files and projects,
ensuring the correct users and permissions are applied to a group. Tools for
commenting, annotating, and file comparison are available to support all stages of
document evolution. Users receive updates when files in particular groups are being
accessed, commented on, or modified by other reviewers, so ideas and conversations
are never missed. Once new file versions are uploaded, users can compare old and
new versions to see at a glance what has changed.

Users can access, review, and collaborate on files from any device, supporting
company-wide mobility initiatives. Users can also select files to save for offline access,
enabling users to work on files without Internet access. Once the device is connected
again, all updates are synced back as a new version.

IT security controls are available at an account level, allowing data governance
regulations to be met, and reduce the risk of accidental data loss. For added security,
organizations can choose where their corporate data is stored (public cloud, custom
public cloud, or hybrid). Finally, Workshare online can be integrated with existing DMS
to securely mobilize content, and get the most out of IT system investments.

With Protect, users can save and share Office files (directly from Office) to Workshare
online so they can access them on their other devices and on the move. Once shared,
users can see their shared document, spreadsheet or presentation come alive and
understand who’s reviewing it online- directly from Word, Excel or PowerPoint.

DMS/CRM Integration

Workshare Protect can integrate with your DMS or CRM as well as SharePoint to
provide PDF functionality.

10
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Note: To integrate with a DMS/CRM or SharePoint, Workshare Protect must be
installed with the relevant integration selected and additional details may need to be
configured in the Workshare Configuration Manager. Refer to your system
administrator for further information.

The specific functionality available with each DMS/CRM integration is detailed in the
table below:

Functionality SharePoi NetDocu iManage OpenText Worldox
nt ments

X

X
X
X

Convert to PDF
(from Workshare
tab)

Combine PDF
(from Workshare
tab)

Right-click:
Convert to PDF
with Workshare

Right-click:
Combine files in
Workshare

v
v
v

X X N AN

Browse from
desktop app to
add files to
Workshare

ACCESSING WORKSHARE PROTECT

Workshare Protect can integrate with Microsoft Word, Excel, PowerPoint and Outlook.
To this end, there is no independently accessed user interface for Protect - the user
interface is accessed from within Word, Excel, PowerPoint or Outlook and is available
from all documents.

Notes: If your Workshare Protect is not integrated with Microsoft Word, Excel,
PowerPoint and Outlook, refer to your system administrator.

1"
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After you have installed Protect, the Workshare tab is added to the ribbon in your
Microsoft Office applications - Word, Excel and PowerPoint. The addition of Protect
does not affect the standard functionality of Word, Excel or PowerPoint. You can
operate these applications as usual and access the Protect functionality as required.

Workshare Protect functionality can also be accessed in the following ways:

o Right-click closed Word documents and select Convert to PDF with Workshare
or Combine files in Workshare or Send to/Workshare Batch Clean.

¢ Right-click closed Excel or PowerPoint documents and select Convert to PDF
with Workshare or Combine files in Workshare or Send to/Workshare Batch
Clean.

¢ Right-click closed PDF documents and select Combine files in Workshare or
Send to/Workshare Batch Clean.

o Right-click any file and select Workshare/Send to Group.

Note: Workshare Protect can be installed without Microsoft Office integration. In this
case, the Workshare tab is not available. The Workshare metadata removal
functionality is only available when sending emails.

Start Menu

After you have installed Workshare Protect, the following elements are added to the
Start menu:
e Under Workshare:
= Workshare Batch Clean
o Workshare Configuration (User Mode)
o Workshare Configuration Assistant
= Help

e Under Workshare Desktop
= Workshare

Batch Clean

Workshare Batch Clean is a tool that cleans hidden data, such as versions, templates,
comments, hidden text, reviewer and author information, from multiple Office
documents at the same time. Refer to Batch Cleaning, for further information.

12
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Workshare Tab

In Office applications, the Workshare tab is included as follows:

. - =&
- L] \
R N © O < 2
Content Combine Convert | Toggle Saveto  Share | Options Help
Risk FDF 1o PDE~ | Fanel Wy Files™ .

Protect Sharing Cptions Info

EEE
I

Whether these options are included in the tab is configurable from the General > User
Interface category in the Workshare Configuration Manager. Refer to Workshare
Configuration Options for further information.

The Workshare tab includes the following options:
Group Item Description

Protect Content @ Enables you to display a report of all the content risk in a
Risk document as well as remove selected hidden data from the
document. Refer to Displaying Content Risk in Documents for
further information.

Combine | Enables you to combine multiple files into a single PDF file.
PDF Refer to PDF Combine for further information.

Convert | Enables you to convert documents to PDF. Refer to
to PDF Converting to PDF for further information.

Sharing Toggle Displays/hides the Workshare Connect panel in your Office
Panel window where you can see what’s happening with a
collaboration in real-time. Refer to Getting Content Online for
further information.

Saveto | Enables you to save documents to Workshare online so they
My Files  will be accessible to you online at all times. Refer to Saving to
My Files for further information.

Share Enables you to share documents to groups in Workshare
online so you can collaborate on them with others. Refer to
Sharing to a Workshare Group for further information.

Options Options | Enables you to configure system parameters in the Workshare
Configuration Manager. Refer to Introducing the Workshare
Configuration Manager for further information.

Info Help Provides access to version, copyright and license information
about Workshare Protect as well as online help.

13
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Enabling Workshare Protect Functionality

To ensure Workshare Protect functionality is fully enabled, you should work with saved
documents. If you are working in Microsoft Office on an unsaved document and you
select Combine PDF, the following message is displayed:

The document needs to be saved

The Workshare functionality you have selected is not
currently enabled for an unsaved document,

LICENSING

After installation, you are prompted to log in to your Workshare account in order to
retrieve your license entitlements. This can be in either of the following ways:

e When File Share & Sync is included in the installation, the Workshare desktop
app is launched after install and you will see the following:

File View Help

(=) Workshare

Welcome, let's get started
Enter your email address to sign in or register

| [Email address

14
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Enter your Workshare credentials (email address and password) and click Sign
in. Your license entitlements are retrieved and you have access to all Workshare
functionality. Your license entitlements are shown in the My Products tab of the
Workshare Configuration Manager.

If you do not log in at this point, then.....

o The first time you access Workshare functionality, for example, by clicking any
option in the Workshare tab, you will see the following:

e Workshare 9 X

Sign in

to validate your Workshare subscription

Password

Forgotten password

Why do I have to sign in?

Create an account

Note: You can also open the Workshare Configuration Manager, select the My
Products tab and click Sign in.

Enter your Workshare credentials (email address and password) for Workshare and
click Sign in. Your license entitlements are retrieved and you have access to all
Workshare functionality. Your license entitlements are shown in the My Products tab of
the Workshare Configuration Manager.

Users who do not yet have a Workshare account can click Create an account in the
login dialog. Workshare checks their email address and will automatically register them
against your corporate Workshare account and update their license entitlement.

15
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CHAPTER 2. PROTECTING
DOCUMENTS

This chapter describes how to view the content risk in documents as well as remove
selected content risk from a document. It includes the following sections:

o Overview — Protection on your Desktop, page 17, introduces the ways in
which Workshare Protect enables you to protect documents by viewing and
removing sensitive content risk.

o Displaying Content Risk in Documents, page 17, describes how to discover
all content risk in Office documents.

o Cleaning Hidden Data, page 19, describes how to remove selected types of
hidden data from a document and from multiple documents.

o Converting to PDF, page 29, describes how to secure your documents by
converting to PDF.

16
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OVERVIEW — PROTECTION ON YOUR
DESKTOP

Note: This chapter describes how to protect documents on your desktop by removing
metadata and converting to PDF. The protection of documents when emailing is
described in Chapter 3: Protecting Attachments.

Workshare Protect offers complete protection of files to ensure they are fully secure
before distribution. Discover what hidden metadata remains in your document, clean it
and then convert the document to PDF ensuring a safe and secure file.

Protect provides comprehensive content risk protection enabling the discovery and
removal of hidden sensitive data as well visible sensitive data. Hidden sensitive data
may include information such as track changes, author’'s name, server names,
keywords, routing slips and authoring trails. Protect integrates with Office providing an
option to display a comprehensive report of all the content risk in a document, displayed
according to its risk level (high, medium, low).

Workshare Protect creates the most secure PDF files available from any application.
You can quickly and easily convert open and closed Microsoft Office documents into
PDF or PDF/A removing hidden data from the document and setting security options as
you do so. Workshare Protect also provides “PDF Anywhere” which is the ability to
convert a document to PDF from any application.

Note: PDF creation can also be enforced on email attachments leaving your
organization. Refer to Chapter 3: Protecting Attachments.

17
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DISPLAYING CONTENT RISK IN
DOCUMENTS

Workshare Protect integrates with Microsoft Office to provide an option to discover and
view content risk in Microsoft Word, Excel or PowerPoint documents.

To discover content risk in your document:

1. Open your document and click Content Risk, (Protect group) in the Workshare
tab.

Workshare Protect checks the document for content risk. This process may take
a few moments if your document is large or if it contains large amounts of
content risk. Once the discovery process is complete, the Document Risk Report
is displayed showing a summary of the content risk found.

I e a an S i |

-

Workshare | Document Risk Report i

Risk Report for:  [[w Draft Release Notes.docx
Time of report:  30/09/2014 16:22:07

|| |Risk Severity: B High Risk Elements 2 4
@ Medium Risk Elements 1 3
B Low Risk Elements 95
| ¥ ] Hidden Data Policy

¥ [ High Risk Elements

¥ 1 Track change

- More explanation {Insertion by Helen Sagal)
¥ 1 Comment

- 1982 1 think {by Helzn Sagal) I

¥ [ Medium Risk Elements

¥ 1 Document reviewer
- Helen Sagal

¥ [l Low Risk Elements 5

e ([} (3

Help Remove | Print | Close

The content risk found is divided into high risk, medium risk and low risk.

2. To display details of the content risk found, click # to the left of the content risk
type.

3. To remove hidden data from the document, use the Remove button. Refer to
Cleaning Hidden Data, for more details.

4. To print the report, click Print.

18



NS =l PROTECTING DOCUMENTS

CLEANING HIDDEN DATA

In Microsoft Office documents, once you have discovered the content risk in a
document, you can remove selected types of hidden data as required. If you want to
remove hidden data from PDF files or from multiple Microsoft Office documents, you
can use the Workshare Batch Clean tool. Refer to Batch Cleaning.

To remove hidden data:

1. Click Remove in the Document Risk Report. The Advanced Options dialog is
displayed.

Workshare Protect

Advanced Options

Choose the hidden data elements you would like deaned in the selected
documents:

=-[Z] Risk Elements

Convert attached template to Normal (Word)
Convert field codes to text (Office)

Delete built-in properties (Office)

[ pelete comments (Office) |
Delete custom properties (Office)

Delete document variables (Word)

Delete hidden text (Word)

Delete routing slip (Word and Excel 2003)
Delete Smart Tags (Word 2003/2007)

[ pelete text smaller than Spt (Word)

; Delete versions (Word 2003)

--[[] Delete white text on white background (Word)
- Turn off versioning (Word 2003)

Help ok || coancel |

A complete list of hidden data that can be removed, reset or converted is listed
in the dialog. Different options will appear according to the type of document —
Word, Excel or PowerPoint. For a full description of the different options, refer to
Cleaning Options.

2. Select the hidden data you want to remove by selecting the checkboxes to the
left of the options.

19
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PROTECTING DOCUMENTS

3. After making your selection, click OK. The selected hidden data is removed from
the document.

Workshare Protect may take a few moments to clean you document depending on the
size of the document and the amount of hidden data to be removed. The Document
Risk Report is updated after the document has been cleaned to show any remaining
content risk. After cleaning, the document with hidden data removed is still stored in
memory only. If you want to keep the cleaned document, you now have to save the
document.

Batch Cleaning

If you want to remove the same types of hidden data from several documents, you can
use the Workshare Batch Clean tool to clean multiple documents (up to 256)
simultaneously.

To clean multiple documents:

1. From the Start menu, select All Programs, Workshare, and then Workshare
Batch Clean. The Batch Clean dialog is displayed.

Batch Clean o
v 'ru-‘"“"x‘
{:)u | L.« Workshare » Modules » R |$?| | Search Modules ol
Organize » MNew folder =~ [l @
o~
< Eavorites MName Date modified Type
B Desktop . Common HTML IUT 06/09/2012 11:23 File folder
& Downloads . Compare HTML IUIT 06/09/2012 11:23 File folder
gl |, Config 06/09/2012 11:23 File folder
L] Recent FI
e e |, de-DE 06/09/2012 11:23 File folder
Fellyd Dictionaries 06/09/2012 11:23 File folder
7 Libraries b i
L ja-Ip 06/09/2012 11:23 File folder
1% Computer . Professional HTML IUL 06/09/2012 11:23 File folder
&, Local Disk (C) . Protect HTML TUT 06/09/2012 11:33 File folder
® deptdata (\worksha . Readme 06/09/2012 11:23 File folder
@ helens [Vworkshare, .. Sample Policies 06/09/2012 11:23 File folder
=? helens [\workshare, sample Modified Document.doc 20/04/2009 17:08 Microsoft W
4 helens Sample Original Document.doc 20/04/2009 17:08 Microsoft W
€ Network
4 ] | 3
File name: - ’Wmd Documents (*.doc™.docx v]
| Open |v| ’ Cancel l

20
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Note: To view more document types, select All Office files from the Files of
type dropdown list. If unsupported file types are selected for batch cleaning,
they will be ignored.

2. Select the documents you want to clean. Press the Ctrl or Shift key to select
multiple documents.

3. Click Open. The Batch Clean dialog is displayed.

Tip! An alternative to steps 1, 2 and 3 is to select the documents in Windows
Explorer, then right-click and select Send To then Batch Clean.

-
)l Workshare Protect - Batch Clean u
' (=) Workshare
Please select the elements you would like to remove from the
batched file list.
Cleaning Elements:

[7] Toggle onfoff

Delete built-in properties (Office)
[7] Accept changes and turn off Track Changes (Word a|
[7] Delete comments (Office)

Delete hidden text (Word)

[7] Delete white text on any background (Word)
[7] Delete text smaller than 5pt (Word)

Delete routing slip (Word and Excel 2003)
Delete custom properties (Office)

Convert field codes to text (Office)

Delete document variables (Word)

Convert attached template to Hormal (Word) 3
Turn off versioning (Word 2003)

Delete versions (Word 2003)

Delete Smart Tags (Word) -

|3

m

Saving:
@ Overwrite files after deaning

(7 Save files to new location after deaning

[ Clean i[ Cancel ]

A complete list of hidden data that can be removed, reset or converted is listed
in the dialog. For a full description of the different options, refer to Cleaning
Options.

21
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4. Select the hidden data you want to remove by selecting the checkboxes to the
left of the hidden data options. All the selected files will be cleaned using the
same options.

Tip! Select the Toggle on/off checkbox to select/deselect all the hidden data
options.

5. Select one of the following save options:
= Overwrite files after cleaning: Selecting this option will save the cleaned
files over the original files, overwriting the existing version.
= Save files to new location after cleaning: Selecting this option will save the
cleaned files to a different location, leaving the original files in their original
location and in an uncleaned state. Click the browse button and select the
new save location.

6. Click Clean. The selected files are cleaned according to your selection. Once
the process is complete, a report is displayed indicating which files were cleaned
successfully.

-
l Workshare Protect - Batch Clean

The following files were processed.

File: Mame
Succeeded
@For Review Original Test UG.docx
@j Plans,docx
Password Protected
@j Comments Roadmap. docx

7. Click Finish.

22



PROTECTING DOCUMENTS

C ) Workshare

Batch Cleaning Using a Command Line
Batch cleaning can be performed using the command line.
To batch clean using the command line:
1. From the Start menu, select Run.
. Enter cmd in the Open field and click OK.

2

3. Enter the clean command required. Samples are given below:

e To clean hidden data from the entire hard disk:
bc-console.exe “c:\” /s /all

e To clean all hidden data from a single document:
bc-console.exe “<filepath>” /all

where <filepath> is the full path to the document to clean.

e To exclude specific data from the cleaning (here comments and track changes
are excluded):

Bc-console.exe “<filepath>” /all /exclude:comments /exclude:trackchanges

e To clean only specified data from the document (here comments and track
changes are the data to clean):

Bc-console.exe “<filepath>” /include:comments /include:trackchanges

For a complete list of options, type the following command:

Bc-console.exe/

-
Administrator: C:\Windows\system32\cmd.exe S | B jd S
C:\Users\helens>Bc—console.exe/

Cleaner 9.0.6.0
All rights reserved.

Wlorkshare Protect Batch

Copyright (C) Workshare Ltd.

Syntax: bhc—console names [options]

Specifies a list of one or more files or directories

Turns on all options for cleaning
Recurse subdirectories

/WriteToFolder:[folder]
/Exclude: [optionname ]

/Include:[optionname ]

optionnames

Urites cleaned files to specified directory
Turns off specific option for cleaning when used
in conjunction with /All

Turns on specific option for cleaning

DocumentStatistics, BuiltInProperties.
SmartTags, Template, Authors,
DocumentVUariabhles, Fields.

Macros, RoutingSlip, SpeakerNotes, Links, Reviewers.,
TrackChanges, Comments, SmallText, WhiteText.
HiddenText, HiddenSlides, AutoUersion, Uersions

Footnotes.
Headers, Footers.
CustomProperties,
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The options are described in the following table:

Option

/A1l

/S

/WriteToFolder: [folder]

/Exclude: [optionname]

/Include: [optionname]

optionnames

Description

All hidden data is removed from the specified documents.

To leave specified types of hidden data in a document,
the /a11 command can be used in conjunction with the
/Exclude command.

The /a11 command cannot be used in conjunction with
the /Include command.

Hidden data is removed from sub-folders of the specified
folder.

The cleaned file is saved to a specified location.

If this command is not included the original file is
overwritten with the cleaned file.

Cleaned files saved using the /writeToFolder cOmmand
will have a flat file structure. If files have the same names,
they will be appended with a number.

Excludes specified types of hidden data from being
removed. The /Exclude command is used in conjunction
with the /a11 command.

The valid types of hidden data that can be excluded are
detailed in the optionnames list.

Specifies which types of hidden data are to be removed.
The /1inciude command is used instead of the /a11
command.

The /1nciude command cannot be used with the /a11
command or the /Exclude command.

The valid types of hidden data that can be specified are
detailed in the optionnames list.

The valid types of hidden data that can be used with the
/Exclude and /Include commands.

Footnotes, DocumentStatistics, BuiltinProperties,
Headers, Footers, SmartTags, Template, Authors,
CustomProperties, DocumentVariables, Fields, Macros,
RoutingSlip, SpeakerNotes, Links, Reviewers,
TrackChanges, Comments, SmallText, WhiteText,
HiddenText, HiddenSlides, AutoVersion, Versions
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Cleaning Options

The different hidden data cleaning options that are selected when cleaning an individual
document or when batch cleaning several documents are explained below:

Option

Accept changes and
turn off Track
Changes (Word and
Excel)

Convert attached
template to Normal
(Word)

Convert field codes
to text (Office)

Description

Microsoft Word and Excel. Accepts all revisions made to the
document. The revisions are therefore no longer displayed
as revisions but rather as text in the document. Track
changes is also turned off so that further revisions are not
tracked.

Microsoft Word only. Converts the attached template to
normal.dot. Automatic style updating is disabled before the
template is removed. Therefore the formatting and styles in
your document will not be affected by removing the attached
template.

To view the attached template: Click the File menu/Office
Button, select Options/Word Options and then select Add-
Ins. From the Manage dropdown list, select Word Add-ins
and click Go.

Microsoft Word, Excel and PowerPoint. Converts any field
codes that exist in a Microsoft Word document to text, for
example, hyperlinks, table of contents, index. In Microsoft
Excel and PowerPoint, hyperlinks are converted to text.

Note: For Microsoft Excel and PowerPoint, hyperlinks are
the only field codes that exist.

This prevents the field codes from being updated after you
have distributed the document. It also prevents errors for
fields that reference built-in or custom properties that have
been removed.

Note: You may want to remove some field codes but not
others. For example, you may want to clean ‘Include text’
field codes, but retain the Table of Contents and Page
Numbers. To do this you can specify the field codes you
want to keep in the Protection > Exclude Metadata
category of the Workshare Configuration Manager, and
then clean field codes as normal. See Workshare
Configuration Options for more details.

To view field codes: Click the File menu/Office Button, select
Options/Word Options and then select Advanced. Select
the Show field codes instead of their values checkbox in
the Show document content area.
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Option Description

Delete attachments PDF only. Removes files that are attached to the PDF as a
(PDF) whole.

Attachments that are linked to a specific point in a PDF file
are not removed. They are treated as markups and will only
be removed if the Delete markups parameter is selected.

Delete bookmarks PDF. Removes any bookmarks in a PDF file.

(PDF)

Delete built-in Microsoft Word, Excel and PowerPoint. Removes all
properties (Office) summary properties - author, category, comments,

company, keywords, manager, title, subject, and hyperlink
base; and custom properties — text, date and number.

To view built-in properties: In MS Office 2010/2013, click the
File menu, select Info and then select Advanced
Properties from the Properties dropdown list in the right
panel. In the Properties dialog, select the Summary and
Contents tabs. In MS Office 2007, click the Office Button,
select Prepare and then select Properties. In the Document
Information Panel, select Advanced Properties from the
Document Properties dropdown list. In the Properties
dialog, select the Summary and Contents tabs.

Delete comments Microsoft Word, Excel and PowerPoint. Removes any
(Office) comments embedded in the document.

To display comments: In MS Office 2010/2013, click the
Review tab and from the Show Markup dropdown list
(Tracking group), select Balloons then Show Only
Comments and Formatting in Balloons. In MS Office
2007, click the Review tab and from the Balloons dropdown
list (Tracking group), select Show Only Comments and
Formatting in Balloons.

Delete custom Microsoft Word, Excel and PowerPoint. Removes any
properties (Office) custom properties that have been added to the document.

To view document properties: In MS Office 2010/2013, click
the File menu, select Info and then select Advanced
Properties from the Properties dropdown list in the right
panel. In the Properties dialog, select the Custom tab. In MS
Office 2007, click the Office Button, select Prepare and then
select Properties. In the Document Information Panel,
select Advanced Properties from the Document
Properties dropdown list. In the Properties dialog, select the
Custom tab.
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Option

Delete document
variables (Word)

Delete footers (Excel
and PowerPoint)

Delete headers
(Excel and
PowerPoint)

Delete hidden slides
(PowerPoint)

Delete hidden text
(Word)

Delete links (Excel)

Delete macros
(Word and Excel)

Description

Microsoft Word only. Deletes all document variables.

Document variables are values stored in Microsoft Word
documents that are used by either field codes or macros.
These variables may contain confidential information like
company names or file locations. Even if field codes and
macros are removed, the variables used may remain in the
document.

Variables can be viewed in Microsoft Word in the Visual
Basic Editor.

Microsoft Excel and PowerPoint. Removes any footers
included in the sheet or slide.

To view headers and footers: Click the Insert tab and select
Header & Footer (Text group).

Microsoft Excel and PowerPoint. Removes any headers
included in the sheet or slide.

To view headers and footers: Click the Insert tab and select
Header & Footer (Text group).

Microsoft PowerPoint only. Removes hidden slides from
Microsoft PowerPoint files. Hidden slides are not required for
a slide show (they are not automatically displayed during a
slide show) but they may contain confidential information.

Microsoft Word only. Removes all text that has been
formatted as hidden.

To view hidden text: Click the File menu/Office Button, select
Options/Word Options and then select Display. Select the
Hidden Text checkbox.

Microsoft Excel only. Converts external links in Microsoft
Excel files to text. The following are examples of external
links:

Link to a cell in another Microsoft Excel document.

Named link to a named reference in another Microsoft Excel
document.

Link to another document.

OLE link that inserts another document as an icon.

OLE link that inserts another document as text.

Microsoft Word and Excel. Removes VBA macros from a
document. This feature is not intended as virus protection,

but rather to protect any confidential information, intellectual
property or formulas included in the macros.

To view macros: Click the View tab and select Macros and
then View Macros.
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Option

Delete markups
(PDF)

Delete properties
(PDF)

Delete routing slip
(Word and Excel
2003)

Delete Smart Tags
(Word 2003/2007)

Delete Speaker
Notes (PowerPoint)

Description

PDF. Removes any markup in a PDF file.

Markup is a tool used to make comments and annotations to
PDF documents.

PDF. Removes properties in a PDF file.

Standard properties are details about a file that help identify
it, including its title, subject, author, manager, company,
category, keywords, comments, and hyperlink base.

Note: Removing properties from a PDF/A file will disable
its PDF/A status.

Microsoft Word and Excel. Removes all entries from a
routing slip, as well as the message subject and text. This
can prevent email addresses of colleagues from being
unknowingly distributed. This also deletes any envelope
information, such as recipients, subject, and introduction,
which are used when sending to a mail recipient.

Routing slips are not supported in MS Office 2007.

To view routing slip entries: From the File menu, select Send
To and then Routing Recipient. To view envelope
information: From the File menu, select Send To and then
Mail Recipient.

Microsoft Word only. Removes smart tags from Microsoft
Word documents.

Smart tags are added to your documents as you create them
if the option is enabled. These tags are linked to particular
text in a document, such as a name, and allow you to
perform certain actions by selecting the link associated with
the text. Depending on the smart tag functions you use, they
may embed extra hidden information in your document.

Smart tags only exist in Microsoft Office XP to 2010.

To manage smart tags: In MS Word 2010, right-click a word,
select Additional Actions and then Options. In MS Word
2007, click the Office Button, select Word Options and then
select Proofing. Click the AutoCorrect Options button and
select the Smart Tags tab.

Microsoft PowerPoint only. Deletes all text that appears on
the Notes Page in a Microsoft PowerPoint presentation. This
is usually used by speakers to remind them of points during
a presentation. You may want to remove speaker notes
before distributing a presentation, as they are not usually
intended for others to read.
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Option Description

Delete text smaller Microsoft Word only. Removes all text that has been

than 5pt (Word) formatted with a font size less that 5pt (i.e. 4pt and less).
Small text can also be detected in Microsoft Excel but it is
not cleaned.

To view small text: Click the View tab, select Zoom and
specify a percentage greater than 100%.

Delete versions Microsoft Word only. Removes any previous versions of the

(Word 2003) document that you may have saved. Previous versions can
be useful while you are developing a document, but often
they can contain confidential information that you have
removed from the main document.

Document versions are not supported in MS Office 2007.
To view versions: From the File menu, select Versions.

Delete white text on = Microsoft Word only. Removes all text with a white font that

white background has been formatted with a white background color.

(Word) To view such text: Click the Page Layout tab and select a
color from the Page Color dropdown list (Page Background
group).

Turn off versioning Microsoft Word only. Turns off the flag to automatically save

(Word 2003) a new version of the document every time the document is

closed. This applies to local file systems only. Versions can
still be saved manually by saving a file with a different name.

Versioning is not supported in MS Office 2007.

CONVERTING TO PDF

At any time when working on a document in Microsoft Word, Excel or PowerPoint, you
can convert the document into PDF or PDF/A. This is useful if you want to maintain a
file in its current format, as PDF documents cannot be edited as easily as Microsoft
Word, Excel and PowerPoint documents. This functionality is available from within an
open document or when the document is closed.

Workshare Protect automatically saves a document before converting to PDF or PDF/A.
Documents can be stored locally, in SharePoint or in your DMS.

To convert a document to PDF or PDF/A:

1. Start in either of the following ways:

o With your document open in Microsoft Word, Excel or PowerPoint, click
Convert to PDF (Protect group) in the Workshare tab.

= Right-click a closed Microsoft Word, Excel or PowerPoint file on your desktop
or DMS and select Convert to PDF with Workshare from the menu.
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The Convert to PDF dialog is displayed.

-
Workshare Protect - Convert to PDF g

EyWorkshare |

Convertyour document to PDF and configure its security options.

Save document as:
@ PDF (.pdf) Optimized for everydsy usage

©) POF/A (.pdf)  Optimized for archiving

| Configure PDF Security |

Select pages to include:
@ All

Enterpage numberand/or pageranges

~p
088 seperated by commas (e.g. 2, 5-8)

View and send
@ None
(©) Open PDF once created

(©) Email PDF as attachment '

s (Comven) Come ) o)

Note: If working with a DMS, the dialog looks slightly different to the one above
and you can select whether to save the PDF as a new document or related
document in your DMS or as a local file.

2. Select whether to convert to PDF or PDF/A.
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3. Click Configure PDF Security to set PDF security options and remove
metadata.

T
Workshare Protect u

} ———

PDF security configuration
[] Prevent printing
[7] Prevent editing of text

[] Prevent the copying of text and/or graphics

[] Prevent comments being added

Metadata cleaning
[ Cleaning Options ] 0 option(s) selected

Password protection

Specify a password forthe generated PDF. Only users withthe
password canopen thedocument.

Spedify password

Confirm password

[ aeoty [ [ concel |

E

4. Select one or more of the following security options:
o Prevent printing: Prevents users from printing the PDF document.
o Prevent editing of text: Prevents users with Adobe Distiller from editing the
PDF document.
= Prevent the copying of text and/or graphics: Prevents users from copying
graphics or text directly from the PDF document.

= Prevent comments being added: Prevents users with Adobe Distiller from
adding comments to the PDF document.

Note: These options are disabled and cannot be selected if you selected
PDF/A in step 2.
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5. To specify what hidden data to remove before converting it to PDF, click
Cleaning Options.

Workshare Protect - - g

} _—

Advanced Options

Choose the hidden data elements you would like deaned in the selected
documents:

=[] Risk Elements
-] Accept changes and turn off Track Changes (Word and Excel)

[ Convert attached template to Normal (Word)
-] Convert field codes to text (Office)

[ Delete built-in properties (Office)

[ pelete comments (Office)

[ Delete custom properties (Office)

[ Delete document variables (Word)

[ Delete hidden text (Word)

[ Delete routing slip (Word and Excel 2003)
-] Delete Smart Tags (Word 2003/2007)

[ Delete text smaller than Spt (Word)

[ Delete versions (Word 2003)

“ Help [ oK |[Canoel ] IJ

6. Select hidden data elements as required. For a full description of all the hidden
data elements, refer to Cleaning Options for further information.

7. Click OK.

8. If required, set a password to protect the PDF by entering the password twice in
the Password protection area. When a password is specified, users can only
open the PDF after entering this password.

Note: If you selected PDF/A in step 2, you cannot set a password and the
Password protection area is disabled.

9. Click Apply.

10. In the Convert to PDF dialog, if you want to create a PDF of part of the
document only, select the Pages radio button and specify a page range.
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Note: You can also PDF individual pages by specifying the pages (separated
by commas) in the Pages field.

11. In the View and send area, select the Open PDF once created checkbox if

you want the PDF to be opened once it has been created or select the Email
PDF as attachment checkbox if you want the PDF to be attached to an email
once it has been created.

12. If required, click Preview to view the document as a PDF.

13. Click Create. The Save As dialog is displayed:

-

LocalStore Save As

2

G-

@ v Libraries p Documents #

v | + | | Search Documenis

2|

4.7 Favorites
. Desktop
ﬂ. Downloads
i# Dropbox
"Ll Recent Places

4 Libraries
| @__ggcuments

[ ,Jﬁ Music
I» [e=| Pictures
-2 E Videos

28 computer
b & Local Disk (C)

‘% Hide Folders

Organize « MNew folder

¥

m

I &8 deptdata (hwork ™ 4 |

Documents library

Includes: 2 locations
Mame

.\ Add-in Express

| Adobe

. Documents

. My Policies

g My RoboHelp Projects
1. Robohelps

J Waorkshare

1 Workshare

Arrange by:  Folder =

Size Date modified

18/05/201111:14
05/07/2011 11:46
29/03/2011 11:49
06/09/2012 15:03
09/08/2012 15:54
05/07/2011 11.37
06/09/2012 15:50
06,09/2012 15:50

[ |

File name: W5 Protect 7.5 User Guide.pdf

- @

Type
File 4
File
File
File
File
File
File
File 1

Save as type: ’PDF Documents (*.pdf)

| Save | ’

Cancel l

b

14. Specify the name and location for the PDF file and click Save. The document is

converted to PDF or PDF/A. If you selected Open PDF once created, the new
PDF is opened. If you selected Email PDF as attachment, an email message
window is displayed with the PDF as an attachment.
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PDF Anywhere

Workshare Protect can convert any document or file to PDF, for example, a page in
Internet Explorer, an email message or a text file in Notepad. You can create a new
PDF from the file or add to an existing PDF.

To convert to PDF from anywhere:
1. Click Print in the application.
2. Select Workshare PDF Publisher as the printer.
3. Specify other settings as required and click Print. The Output File Name dialog

is displayed.

Cwtput File Name u
ok <] « Bt E-
Mame Size Date modified =

o . Add-in Express 15/05/2011 11:14 i
| Adobe 05/07/2011 11:46 3
. Documents 29/03/2011 11:49
.. My Policies 06,/09,/2012 15:03
L My RoboHelp Projects 09,/08/2012 15:54
‘1 Rohnheln9 O507/2011 11:37 i
1 | ] | 3

File name: |F‘Ians.pdf OK I
Files of type: I‘_pdf d Cancel |

[T Concatenate

Properties. .. |

4. Specify a name for the PDF in the File name field or, if you want to add to an
existing PDF, select the Concatenate checkbox and browse to and select the
existing PDF.

4

5. Click OK. The open document is converted to PDF and saved as specified or
added to an existing PDF.
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CHAPTER 3. PROTECTING
ATTACHMENTS

This chapter describes the Workshare Protect functionality with regard to identifying
content risk in emails and their attachments. It includes the following sections:

* Introducing Attachment Protection, page 35, introduces how Workshare
Protect protects your files when sending by email.

o Interactive Protect, page 40, describes how to use Interactive Protect to secure
your emails.

o Using the Protect Profile Dialog, page 49, describes how to send secure
emails using the Workshare Protect Profile dialog.

o Using the Email Security Dialog, page 55, describes how to send secure
emails using the Workshare Protect Email Security dialog.

o Sending Links to your Files, page 69, describes how to use the secure file
transfer functionality to upload attachments to Workshare online and send
recipients links to the files.
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INTRODUCING ATTACHMENT PROTECTION

Note: This chapter describes how to protect documents when emailing by removing
metadata or converting to PDF or using secure file transfer. The protection of
documents on your desktop is described in Chapter 2: Protecting Documents.

Workshare Protect provides security and protection for email attachments. It is able to
process the emails you send to ensure security in the following ways:

e Remove metadata from attachments
o Convert attachments to PDF or PDF/A
e Send attachments to a secure location and send recipients a link to that location

o Compress multiple attachments into a single zip file

Whether Workshare Protect processes your emails is determined by the Apply
Workshare Protect parameter in the Workshare Configuration Manager (Protection >
Administration category). Your administrator may have selected that Workshare
Protect processes emails to external recipients only, emails to internal recipients only,
all emails or no emails.

When Workshare Protect is “on”, the user experience when sending emails will vary
depending on which option your administrator has selected for the After an email with
attachments is sent show parameter in the Workshare Configuration Manager
(Protection > Administration category).

Interactive Protect

Protect Profile dialog using desktop profiles
Protect Profile dialog using server profiles
Ernail security dialog while discovering risk
Ernail security dialog for all mail

Ernail security dialog for internal mail only
Ernail security dialog for external mail only
Mo dialog (process actions transparently)

Pratect Profile dialog using desktop profiles M

When sending emails, you may experience one of the following three options:
e Interactive Protect panel
o Protect Profile dialog

o Email Security dialog
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Interactive Protect Panel

Workshare Protect - X

5 Comments, 1 Tracked Change in your

ell as other hidden metadata,

Clean files

Remove metadata <
Convert to PDF G
[ Convert selected file{s)

Compress all to zip &
[l Compress all

Convert to link G

[[] Replace all attachments with a link

Help Apply

The Interactive Protect panel is displayed when Interactive Protect has been selected
for the After an email with attachments is sent show parameter in the Workshare
Configuration Manager (Protection > Administration category).

The Interactive Protect panel is described in Using Interactive Protect.
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Protect Profile Dialog

ﬁw"mr‘él’:ﬁm )
(=) Workshare

Choose an Email Security Profile

Select security profile you wish to apply to your email

/ Default
Attachments will be processed as defined in the Workshare Configurat...

Clean
All mebodata will be removed from Word, Excel PowerPoint and PDF...

Clean & PDF
All metodata will be removed from Word, Excel, PowerPoint and PDF...

Clean & Secure File Transfer
Attachments are uploaded to Warkshare Online and sent as a link,

Secure File Transfer
Attachments are uploaded to Warkshare Online and sent as a link.

Advanced Options

=l -

The Protect Profile dialog may be displayed in different ways depending on the option
selected for the After an email with attachments is sent show parameter in the
Workshare Configuration Manager (Protection > Administration category).

o Protect Profile dialog using desktop profiles: The Protect Profile dialog is
displayed after clicking Send. It provides a list of profiles available locally from
which you can select to apply to your email (shown above).

o Protect Profile dialog using server profiles: The Protect Profile dialog is
displayed after clicking Send. It provides a list of profiles available on Workshare
Protect Server from which you can select to apply to your email.

The Protect Profile dialog is described in Using the Protect Profile Dialog.
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Email Security Dialog

-
Workshare Protect - Advanced Email Security Options . . ™ .
Summary |Poljcies I Office Metadata | POF Metadata | Secure File Transfer (SFrjl
Select File Apply Action
i Select Al Actions \’E_J Metadats Removal
| 2 Original Test UG - Copy.docx _ Remove Comments
= | mEmE High Risk Remove Track Changes
‘ ““““““““ ““_ “““ [] skip Cleaning
- System Requirements.docx B [] skip Office Metadata Cleaning View Options
BEES High Risk = [7] skip PDF Metadata Cleaning View Options
- Plans.pdf _@ Workshare Secure PDF
mEEs Medium Risk
N | i [| Convert to POF
.
. message subject/body . .
| = EEEE [ g Risk Tr_lggered Policies
| | I 2] Hidden Data Policy
't=_] Workshare Upload Policy
] Send for Review Policy
] POF Hidden Data Policy
Help View Risk Report [ serd || conce |
L

The Email Security dialog may be displayed in different circumstances depending on
the option selected for the After an email with attachments is sent show parameter
in the Workshare Configuration Manager (Protection > Administration category).

Email Security dialog while discovering risk: The Email Security dialog is
always displayed. It is displayed immediately after clicking Send while
Workshare Protect checks the email against the default profile. The options are
enabled once the check is complete.

Email Security dialog for all mail: The Email Security dialog is always
displayed. It is displayed after clicking Send once Workshare Protect has
checked the email against the default profile.

Email Security dialog for internal mail only: The Email Security dialog is
displayed when an email has internal recipients. It is displayed after clicking
Send once Workshare Protect has checked the email against the default profile.
For email to external recipients only, the Email Security dialog is not displayed.
This is only relevant when Apply Workshare Protect is selected for Internal
Email.
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o Email Security dialog for external mail only: The Email Security dialog is
displayed when an email has external recipients. It is displayed after clicking
Send once Workshare Protect has checked the email against the default profile.
For email to internal recipients only, the Email Security dialog is not displayed.
This is only relevant when Apply Workshare Protect is selected for External
Email.

e No dialog (process actions transparently): The Email Security dialog is not
displayed. Workshare Protect processes the email and applies the default profile
without any user intervention.

The Email Security dialog is described in Using the Email Security Dialog.

USING INTERACTIVE PROTECT

The Interactive Protect panel offers you options to control your documents and secure
attachments before sending your email.

e Clean files: Enables you to clean metadata from your attachments.
e Convert to PDF: Enables you to convert attachments to PDF or PDF/A.

e Compress all to zip: Enables you to compress all attachments together into one
zip file.

e Convert to link: Enables you to send your documents to a secure folder in
Workshare online and send recipients a link to that location.

To work with Interactive Protect:

Open Outlook and create a new email. Attach one or more files. Immediately
Workshare Protect reports on the metadata found in a notification across the top of your
email and the Interactive Protect panel on the right side of your email.
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QIH9 s vl Untitled - Message (HTML) = Bo=

i Message | Insert Options Format Text
&) B 5 i
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Adobe PDF o @

ﬂ @ ﬂ JM @ _‘3” ¥ Follow Up * f:{
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Attach Protect Paste v ;'_ £ Address Check | Attach Attach Signature | Assign Zoom
as Link  Files - F - = T Book Mames File Item~ - Policy- # LowImportance
Workshare Clipboard 1 Basic Text () Mames Include Tags | Zoom

IA Comments, white text and other hidden metadata was detected in your attachments.

To.u

Send

| White Text in yo

a,

|
|

subject | |
|

Attached: |6 sample Modified Document.doc (42 KB): # sample Original Document. doc (44 KB

= Clean Tiles ®
EQ. Remave metadata
-
Convert to PDF &
[F] Convert selected file(s)
Compress all to zip °©
[l compress all
Convert to link &
[E] Replace all attachments with a link

Note: If the Interactive Protect panel doesn’t open automatically, click the notification
or click Protect Files in the Message tab.

Using the options in the panel, you can clean metadata from the attachments, convert
them to PDF and compress them in a zip file — all before sending the email. You can
preview exactly what the processed attachments will appear like to the recipients
BEFORE sending the email. Additionally, you can send the attachments to a secure
location in Workshare online and send a link to that location to the recipients.

After selecting the required options, you must click Apply and then you can write your
email while the changes are being applied before finally clicking Send once you are
confident that what you are sending is secure and safe.

If you do NOT click Apply before sending the email, one of two things can happen:

o If the parameter to automatically apply on send is selected in the Workshare
Configuration Manager (Protection>Interactive Protect category), the
Interactive Protect settings made in the panel will still be applied when you click
Send.

o If the parameter is not selected, no processing will occur.

Note: If you create an email with an attachment, clean with Interactive Protect and
then close the email, you are not prompted to save the email BUT the email is saved
to your drafts folder.
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Cleaning Metadata Using Interactive Protect

In the Interactive Protect panel, you can leave the Remove metadata checkbox
selected (this is selected by default) and click Apply. All metadata is removed from all
the attachments.

To select specific metadata to remove from each attachment, you can expand the
Clean files section.

Workshare Protect * X

s 1 Tracked Change, 1 Comment in your files

= other hidden metadata

Clean files 'ﬂ'
Remove metadata

@ Statistics.docx v

®l] Draft Release Notes.docx A
Select metadata to remove:
[ selectAll
[C] Tracked Change: 1
[[] comment: 1
Reviewer: 1
Fields: & [ Excluded 80 fields )
Document Statistics: &
Builtin Properties; 3
Smart Tags: 69
[¥] attached Template: 1

Yiew risk report

Help Apply

You can expand each attachment and adjust the metadata to remove for each one by
selecting/deselecting the checkboxes.

Note: To view a detailed report of the metadata found in an attachment, click View
risk report.

Click Apply and the selected metadata is removed from each attachment.

You can write your email while the attachments are being cleaned and then preview the
files by opening the cleaned attachments. Finally click Send once you are confident that
what you are sending is secure and safe.
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® Collaborating Using Interactive Protect

When you work with Workshare online, you can send attachments to a secure location
in Workshare. The attachment to your email is saved in a folder in your Workshare Sent
folder in Folders and the recipient receives a link to the file.

To send a link to attachments:

1. In the Interactive Protect panel, select the Replace all attachments with a link
checkbox.

2. To change the permissions set for the attachments in Workshare or to set an
expiry date, expand the Convert to link section.

Workshare Protect v X

Convert to link
Replace all attachments with a link

@

Recipients easily retrieve files from a secure
location. Privacy is ensured by end-to-end HTTPS
transfer and 256-bit AES encryption.

What will my recipientis) see?
Set permissions for recipients:
Recipients must login to access files

Recipients can download files
Recipients can invite others to this folder

m

Setan access expiry date

:I:I Mo expiry date B |

[] Getreturn receipt —

Help Apply

3. Deselect any of the following permissions for the attachments as required:

= Recipients must login to access files: When selected, the recipient must
be a Workshare user and must log into Workshare in order to access the files.

o Recipients can download files: \WWhen selected, recipients can download the
files.

1

43



PROTECTING ATTACHMENTS

C:] Workshare

= Recipients can invite others to this folder: When selected, recipients can
share the folder where the attachments are stored.

4. If required, select an expiry date for the files. After this date, recipients will no
longer be able to access the files.

5. Select the Get return receipt checkbox if you want to receive an email once the
recipients have accessed the files.

6. Click Apply. You can write your email while the attachments are being
processed and then preview the files in Workshare online by clicking the link.

Tip! You can clean, convert to PDF or compress the attachments before
uploading to Workshare online using options in the Interactive Protect panel.

EH®S® "t s Untitled - Message (HTML) 2 B e H X
MESSAGE INSERT OPTIONS FORMAT TEXT REVIEW ADOBE PDF
X 12 A [aa]l 2% il attach File ﬂ |™ Follow Up ’
Rl R @ gy B 3" Q4
= = = ttach ltem - 3 : High Importance
Attach Protect Paste | i T SEE Address Check : Assign Zoam | Appsfor
asLink Files - ¥ A-1=== Book Nemes | Signatura™  pgjicy« ¥ LowImportance Office
Workshare Clipboard = Basic Text Mames Include Tags = Zoom Add-ins -
v X
| @ Your files have been processed and are ready to send. |
T
[ T | Workshare Protect K
T
| ce || | 67 Small Text, 2 Builtin Properties in
Subject i i 5 other hidden metadata
Attached i@Samgle Modified Document.xhtml (536 B} ;
i |© sample Orginal Docwmentuntmi 5388 @ Menage permissions - | Clean files ®
=1 [1 Remove metadata
. _ Convert to PDF @
I've shared files with you: [ Convert selected fle(s)
= sample Modified Document.docx Compress all tozlpy )
=| 308Kb [ Compress all
— Sample Original Document.docx
= 307 Kb
View the files Help Apply

If required, click Manage Permissions in the attachments bar and change the

permissions set for your files.

7. Finally in your email, click Send once you are confident that what you are

sending is secure and safe.

The attachments are uploaded into a single folder in your Sent folder in Workshare
online and in the recipients’ Received folder. The name of the folder is whatever you

entered in the Subject field.
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The folder is created as soon as the attachments are converted to links and if you look
in Workshare before you click Send, you will see the folder and the names of the files
with upload pending.

B Sent Send for Review

a Y Find
£ Uploading 2 files sent by email w
E.Li Sample Criginal Document.docx Uploading pending...
'{; Sample Modified Document.docx Uploading pending...

Once your email is sent, the files are uploaded to Workshare. The recipients will receive
your email straightaway and they can click the link to view the files in Workshare. If the
files are still uploading, upload pending is displayed.

Converting Attachments to PDF Using Interactive Protect

In the Interactive Protect panel, you can select the Convert selected file(s) checkbox
in the Convert to PDF section and click Apply and all attachments are converted to
PDF.

Tip! You can clean attachments before converting to PDF. You can also convert to
PDF after converting your attachments to links.
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To select specific attachments to convert and to specify PDF conversion settings for the
attachments, you can select the Convert selected file(s) checkbox and expand the
Convert to PDF section.

Workshare Protect v X

Convert to PDF -
Convert selected file(s)

@) sample Original Document.docx

@) sample Modified Document.docx

Selectformat: @ PDF () PDF/A
Allow users to:

SelectAll
Print
Edit Text
Copy text and/or graphics
Add comments

Set a password for access

Add a password

Confirm password

-

e Deselect any attachments you do NOT want converting to PDF.
¢ Select whether to convert the attachments to PDF or PDF/A.

o Select all or some of the following security options:
o Print: Enables recipients to print PDF files.
o Edit Text: Enables recipients with Adobe Distiller to edit PDF files.

o Copy text and/or graphics: Enables recipients to copy graphics or text
directly from PDF files.

= Add comments: Enables recipients with Adobe Distiller to add comments to
PDF files.

Note: These options are not available if you selected PDF/A.

e If required, set a password to protect the PDF files by entering the password
twice. When a password is specified, recipients can only open the PDF files after
entering this password.

Note: This option is not available if you selected PDF/A.

Click Apply and the selected PDF settings are applied to all attachments that you have
selected to convert to PDF.
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You can write your email while the attachments are being converted and then preview
the files by opening the converted attachments. Finally click Send once you are
confident that what you are sending is secure and safe.

Compressing Attachments Using Interactive Protect

In the Interactive Protect panel, you can select the Compress all checkbox in the

Compress all to zip section and click Apply and all attachments are compressed into
a single zip file.

Tip! You can clean attachments before compressing and then upload the zip file to
Workshare online.

To set a password for the zip file, you can select the Compress all checkbox and
expand the Compress all to zip section.

Compress all to zip o
Compress all

Set a password for access

Add a password

Confirm password

If required, set a password to protect the zip file by entering the password twice. When
a password is specified, recipients can only open the zip file after entering this
password.

Click Apply and all the attachments are compressed into a single zip file called
Attachments.zip.

You can write your email while the attachments are being compressed and then
preview the files by opening the zip attachment. Finally click Send once you are
confident that what you are sending is secure and safe.
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Password Protected Files and Interactive Protect

When you attach a password-protected file, Workshare cannot clean or convert the file
unless you enter the password. Warnings are shown in your email window as follows:

HED G+ |- Untitled - Message (HTML)

i Message | Insert Options Format Text Review Adobe PDF & e
53 ‘D |T'3 % Arial £ 0 Attach File 13“ ¥ Fallow Up = q
@ =] gy E| I ﬂ -

le;i\ttachItemv ! High Importance
Attach Protect Paste

Address Check Assign Zoom
ab g
as Link  Files -~ F |- é' Book Names | | Signature = Policy» # Low Importance
Workshare Clipboard 1 MNames Include Tags fa | Zoom
- X
/.. Password required to discover metadata. ‘
Workshare Protect - X
Tor 1] |
{ =_l
= .| |
e Password required to discover metadata,
Subject: | |
Attached: v p i 1
|@£"—”—9ﬂ5—‘f£99——|\48 _| ) Some files are password protected »
&
[ Clean files °
Remove metadata

& Annual Report.docx

_—----—-----""""----1
Compress all to zip ®
] compress all

Convert to link

©

[F] Replace all attachments with a link

Help Apply
.4

In order to proceed and clean the attachment or convert it to PDF, you must enter the
open/modify password.

Click the @ icon. The Password required dialog is displayed.
Password required =]

The attachment helen release draft.docx is passwoard-protected. In order

for Workshare Protect to process the attachment, a password must be
entered.

Open Password:

Modify Password:

oK Skip | | cance
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Enter the open or modify passwords (or both) and click OK.

You will now be able to expand the attachment in the Interactive Protect panel and
select which metadata to remove or whether to convert the attachment to PDF.

Note: You can send links to password-protected attachments and compress them
without the need to enter the open/modify password.

USING THE PROTECT PROFILE DIALOG

The Protect Profile dialog provides a simple Ul that enables you to select what profile to
apply to your emails.

A profile is a collection of policies that include a set of instructions to Workshare Protect
as to what metadata to remove from an email attachment, whether to convert the
attachment to PDF and whether to upload the attachment to Workshare online and
send a link instead.

Metadata settings and PDF instructions are specified per file type — Microsoft Word
documents, Excel spreadsheets and PowerPoint presentations as well as PDF files. So
for example, a profile could specify that comments and hidden text should be removed
from Microsoft Word attachments and the document should be converted to PDF, and
only hidden worksheets should be removed from Microsoft Excel attachments and they
should not be converted to PDF.

Your administrator defines profiles. Your administrator may have adopted a task-based
approach or recipient-based approach when creating profiles:

o Task-based profiles: For example, you are working on a legal document and
sending it to colleagues to receive input. You email it and select the “Working
Draft” profile which will remove metadata but keep track changes and
comments. After receiving input and implementing changes, you email it and
select the “Final Draft” profile which will remove metadata and remove track
changes and comments. Once you are happy with the document, you email it
and select the “Final” profile which will remove metadata, track changes and
comments and convert the document to PDF.

o Recipient-based profiles: For example, your company has a policy that
whatever documents you send to opposing counsel, the metadata must be
removed and the document must be converted to PDF. You therefore have a
profile called “opposing counsel” which removes metadata and converts to PDF.
You also have a profile called “Personal” which does nothing.

These are just examples of the types of profiles that might be defined. If you have any
questions or requirements regarding the profiles, contact your administrator.
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To send an email:

1. Create a new email, attach the required document(s) and click Send. The
Protect Profile dialog is displayed.

Choose an Email Security Profile

Select security profile you wish to apply to your email

/ Default
Aftachments will be processed as defined in the Workshare Configurat..

Clean

All metadata will be rermoved from Word, Excel, PowerPoint and PDF...
Clean & PDF

All mebodata will be rermoved from Word, Excel, PowerPoint and PDF...
Clean & Secure File Transfer

Attachments are uploaded to Workshare Online and sent as o link.

Secure File Transfer
Attachments are uploaded to Workshare Online and sent as a link.

Advanced Options

Em -

2. Select the profile you want to apply to your attachments and click Send. The

following profiles are provided with Workshare Protect:

= Default: Attachments are processed according to the settings in the
Workshare Configuration Manager.

= Clean: All metadata is cleaned from Microsoft Word, Excel, PowerPoint and
PDF attachments.

= Clean & PDF: All metadata is cleaned from Microsoft Word, Excel,
PowerPoint and PDF attachments and Microsoft Word, Excel and PowerPoint
attachments are also converted to PDF.

= Clean & Secure File Transfer: All metadata is cleaned from Microsoft Word,
Excel, PowerPoint and PDF attachments and then the attachments are
uploaded to Workshare online and recipients are sent a link to the
attachments. Refer to Secure File Transfer Profiles, page 51.

o Secure File Transfer: Attachments are uploaded to Workshare online and
recipients are sent a link to the attachments. Refer to Secure File Transfer
Profiles, page 51.
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If you want to send your email without Workshare Protect processing the attachments,
click the arrow on the Send button and select Send without processing.

If you want to access the Email Security dialog and specify personal settings or
individual settings for each attachment, click the Advanced Options link. The Email
Security dialog is displayed with options matching the profile selected. Refer to the next
section for a description of the Email Security dialog.

Note: Your administrator may not have enabled the Secure File Transfer profiles or
the Send without processing option or the Advanced Options link.

Secure File Transfer Profiles

You can upload almost any file to Workshare online and send any recipient a link to
where the document is stored. All recipients will be able to view the document in
Workshare online in a browser and those recipients who have a Workshare account will
also be able to collaborate on the documents by adding comments in real-time and
uploading versions.

To securely transfer files:

1. Create a new email, enter the recipient email addresses and attach the required
document(s).

2. Click Send. The Protect Profile dialog is displayed.
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3. Select Secure File Transfer or Clean & Secure File Transfer (if you want to
remove metadata from the attachments before uploading them to Workshare
online).

(=) Workshare

Choose an Email Security Profile

Select security profile you wish to apply to your email

Default

Attachments will be processed as defined in the Workshare Configurat..
Clean

All metadata will be removed from Word, Excel, PowerPoint and PDF...
Clean & PDF

All metadato will be removed from Word, Excel, PowerPaint and PDF...
Clean & Secure File Transfer

Attachments are uploaded to Workshare Online and sent as a link.

/ Secure File Transfer
Aftackments are uploaded to Waorkshare Online and sent as a link.

Advanced Opftions

=m -

Note: Click Advanced Options if you want to configure specific user access to
the documents in Workshare. Refer to Setting Advanced Options.

4. Click Send. The attached files are uploaded into a single folder in your Sent
folder and the recipients Received folder (in Folders in Workshare online). The
name of the folder is whatever is entered into the Subject field of the email
followed by the date and time.

Note: If you are not already logged into Workshare, you may be asked to log in
first.
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Setting Advanced Options

If your administrator has given you the rights to access the advanced options, you can
set access rights to documents that you upload to Workshare online to control recipient
access. Clicking Advanced Options in the Protect Profile dialog enables you to

configure specific user access to the documents you are uploading to Workshare
online.

To configure advanced options:

1. Create a new email, enter the recipient email addresses and attach the required
document(s).

2. Click Send. The Protect Profile dialog is displayed.

3. Select Secure File Transfer or Clean & Secure File Transfer and click
Advanced Options. The Advanced Email Security Options dialog is displayed.

4. Select the Secure File Transfer Action tab.

-
Workshare Protect - Advanced Email Security Options ?
(=) Workshare
Summary ] Policies I Office Metadata || Secure File Transfer Action ‘
Select File Apply Action
Select A Actions Secure File Transfer Action
Apply Action
@u Sample Modified Document.docx
——| wmmm LownRisk [7] Users must login to access folder
"""" T == Recipients may invite other
@‘f l ““' Lo:';;:'" LEE SFT Expire access to files on:
P Pl R O | [Flo3/10/2014 @~
., message subject/body [ Get return receipt
_‘ mmEE Low Risk
''''''''''''''''''''''''''''''''''''''''''''' Allow recipients to:
Download files
Go to Summary
Help View Risk Report [ Send ] [ Cancel ]

—

5. You can configure the following parameters:

Apply Action When selected the selected profile (Secure File Transfer or
Clean & Secure File Transfer) is applied to the email. When
not selected, the email is sent without a profile being applied.
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Users must When selected, the recipient must log into Workshare in order
login to access to access the file. When not selected, the recipient can
folder access Workshare without being a registered user to view

and download the file only.

Recipients may When selected, recipients can forward the link to other
invite others to recipients who will be able to access the file. Unless Users

this folder must login to access folder is selected, this option is always
selected.

Expire access You can specify an expiry date for the file. After this date, the

to files on: recipient will no longer be able to access the file.

Get return When selected, you will receive an email once the recipient

receipt has accessed the file.

Download files When selected, recipients can download the file.

Note: The default settings of these parameters are set in the Workshare Policy
Designer.

6. You specify these settings for the files selected on the left side. So you can
select multiple files and set the same settings for all or you can select an
individual file and specify settings individually.

7. Click Send. The attached files are uploaded into a single folder in your Sent
folder and the recipients Received folder (in Folders in Workshare online). The
name of the folder is whatever is entered into the Subject field of the email
followed by the date and time.

Receiving Links to Files in Workshare Online

Recipients of emails sent using Secure File Transfer from the Protect Profile dialog
receive an email with details of the name of the file and a link to click to access the file
in Workshare online. The means of access and options available to the recipient will
vary depending on whether the recipient is a Workshare user and the settings specified
by the sender. Scenarios include:

¢ When a recipient is a Workshare user, clicking the link displays the location in
Workshare online where the file (or files) is stored. The file or files are stored in a
folder with a name that matches the subject of the email. This folder appears in
the recipient’s Received folder (in Folders in Workshare online). The recipient
can add comments to the file, upload versions and make changes to the folder
where the file is stored.

o If the sender has specified that the recipient need not be a Workshare user,
clicking the link displays the location in Workshare online where the file (or files)
is stored. The recipient can view the file and download it.

54



ENIS = PROTECTING ATTACHMENTS

o If the sender has specified that the recipient must be logged in to Workshare,
clicking the link displays the Workshare login and the recipient must first log in to
Workshare in order to view the file (or files) and download it.

o If the sender has specified an expiry date then the link will only work until the
expiry date. Once the date has passed, the recipient will not be able to access
the file.

USING THE EMAIL SECURITY DIALOG

When you send an email using the Email Security dialog configuration, Workshare
Protect checks any attachments to see if they breach any security policies defined in
the default profile. A security policy defines the conditions that must exist in order for
Workshare Protect to detect content risk and the actions that should be taken when the
conditions are met (i.e. content risk is found).

When deciding which policy to apply, Workshare Protect checks each recipient. If an
external recipient is found, external policy settings are applied. Only if all recipients are
internal, are internal policy settings applied. For example, an attached document could
contain hidden data that should not be sent to external parties but is suitable for
distribution internally.

The options available to you depend on the security policies in place in your
organization and the action specified for a policy breach. The different actions are as
follows:

o Block Action: This action blocks your attempts to send the email until the
offending information is removed. See Resolving Blocked Emails for more
information.

¢ Alert Action: This action alerts you to content risk contained within your email,
although you are still able to send the email. See Reviewing Alerts for more
information.

o Clean Action/Lightspeed Clean Action/PDF Clean: This action cleans the
attachments before sending the email. See Cleaning Hidden Data from
Attachments for more information.

o PDF Action: This action converts attached documents to PDF before sending
the email. See Converting Attachments to PDF for more information.

Note: Using the Apply Workshare Protect parameter in the Workshare Configuration
Manager (Protection > Administration category), Workshare Protect can be
configured to NOT check attachments of emails sent internally or externally (or both)
to see if they breach any security policies. If you have queries about your email
security settings, refer to your administrator.
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Password-Protected Documents

When an attachment is encrypted (password-protected), Workshare Protect requires
the password in order to check the document. Password-protection here refers to the
file encryption functionality available in Microsoft Word where the user can set a
password that must be entered in order to open or modify the document.

Note: This functionality is available by clicking the File menu/Office button, selecting
Save As and from the Save As dialog, clicking Tools and then selecting General
Options.

When sending an email with an attachment that requires a password in order to be
opened or modified, a Password dialog is displayed. For example,

i ==

This attachment is encrypted:
Original Protected TestUG.doot

To bypassscanning forthis attachment, click Skip.
Toabandon sending the email, click Cancel.

Open Passwaord
|

Modify Password

OF [ Skip ][ Cancel ]

Enter the password required to open the document in the Open Password or Modify
Password field and click OK, or you can click Skip and Workshare Protect will not
check the document.

When an attachment is a protected document, Workshare Protect also requires the
password in order to check the document. Protected document refers to the “Protect
Document” functionality available in Microsoft Word where the user can restrict specific
users from editing specific sections of the document. The protection settings are
protected by a password.

Note: This functionality is available from the Review tab (Protect group) — click
Restrict Editing (Word 2010/2013) or click Protect Document (Word 2007).
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When sending an email with an attachment that is a protected document, a Password
dialog is displayed. For example,

This attachment is a protected document and requires a
password to editic
easy doo.doo

To bypass scanning forthis attachment, dick Skip.
To abandon sending the email, click Cancel.

Document Protection Password

oK [ Skip H Cancel ]

Enter the password required to open the document in the Document Protection
Password field and click OK, or you can click Skip and Workshare Protect will not
check the document.

Send and Protect

Your administrator may have configured Workshare Protect to include a Send and
Protect button in your message window. If so, you can click this button instead of
clicking Send and the Email Security dialog will always be displayed — regardless of
how the When sending an email with attachments show parameter is configured in
the WCM. You can then select to clean attachments or convert attachments to PDF as
required.
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Sending Emails

The following procedure describes how to send emails using the Email Security dialog.
To send an email:

Create a new email, attach the required document(s) and click Send. The Email
Security dialog is displayed.

Note: If the Email Security dialog while discovering risk option has been selected
(When sending an email with attachments show parameter, Protection >
Administration category), the Email Security dialog is displayed immediately while
Workshare Protect checks the email against the default profile. The options are
enabled once the check is complete (see example screen below). When this option is
not selected, a progress bar is first displayed and the Email Security dialog is only
displayed once the check is complete.

r ™
Workshare Protect - Advanced Email Security Options M
Summary | Policies
Select File Apply Action
Select Al Actions

. message subject’body e Remove Comments

Scanning your email for risk emove Track Changes
""""""""""""""""""""""""""""""""""" ip Cleaning
Skip Office Metadata Cleaning

|| Skip PDF Metadata Cleaning

] Plans - Copy.docx n,
| Scanning your document for risk

Scanning your document for risk i
i || Convert to PDF

-~ Plans.pdf e -ﬁ Workshare Secure PDF

&%  Modified Test UG.docx "
“|  Scanning your document for risk

Triggered Policies

e e

This dialog alerts you to any breaches of security policies in the default profile triggered
by your email or its attachments. If your administrator has given you permissions, you
can modify the settings for each attachment. Refer to Quick Tour of the Email Security
Dialog for further information about the options available.
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If the Email Security dialog while discovering risk option has been selected and you
click Send before Workshare Protect has finished checking the email, the email is sent
and the attachment(s) is processed according the settings in the default profile. This
mean that the actual metadata that is cleaned and the settings used for converting to
PDF are taken from the default profile.

Click Send and Workshare Protect processes the email as specified.

Quick Tour of the Email Security Dialog

The Email Security dialog includes several tabs. The number of tabs may vary
according to the policies triggered but there will always be a Summary tab and a
Policies tab.

Tip! Click View Risk Report if you want to print a risk report detailing the content risk
discovered in the attached document(s). The risk report enables you to evaluate the
content risk contained in the selected attachments.

Select File Area

The Select File area is the same in every tab. It includes a list of the email attachments
that have triggered a policy.

Select File For each item, you can see the risk
level and the actions to be applied to

[ Select Al Adions | the item. You can select individual
_ : attachments or select the entire list by
W selecting the Select All checkbox.
------------------------------------------------------- When a Clean or PDF action is to be
WS Professional 7 Release Notes.pdf === | applied, you can double-click an item

S Gk ik in the list to preview what it will look

FYERRL like once the actions have been

applied. For example, if an attachment

______________________________________________ BT [ in DOCX format will have the PDF

action applied, double-clicking this

DOCX attachment will enable you to
preview it as a PDF.

Help Topics.docx
mmme Medium Risk

Double-click to previewthe cleaned document:
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The Apply Action area of the Summary tab provides one-click checkboxes to change
details of the Clean and PDF actions as well as a list of triggered policies which
provides links to the policies that triggered the actions.

Apply Action

Metadata Removal

[7] Remove Comments

[7] Remove Track Changes

[7] Skip Cleaning
[ skip Office Metadata Cleaning View Options
["] skip PDF Metadata Cleaning View Options

_@ Workshare Secure PDF
[T] Convert to PDF View Options

Triggered Policies

ﬂ Document Conversion Policy
'L] Hidden Data Policy

) Hidden PDF Data Policy

Under Metadata Removal, selecting
Remove Comments or Remove Track
Changes cleans comments or track
changes from the selected attachment.
Selecting one of the Skip Cleaning
options means the selected attachment
is not cleaned at all. Click View Options
to display all options in the Office
Metadata/PDF Metadata tabs.

Under Workshare Secure PDF,
selecting Convert to PDF means the
selected attachment is converted into
PDF. Click View Options to display all
options in the Convert to PDF tab.

Under Triggered Policies, there is a list
of policies triggered by the email and its
attachments. Click the name of a policy
to see more information about the policy
in the Policies tab.

Note: The availability of checkboxes and options may appear differently depending on
your organization’s security policies included in the default profile. Any options that are
disabled have been locked. Refer to your system administrator if you need to override

these settings.
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Policies Tab

The View Policies area on the right side of the Policies tab provides detailed
information about the policies breached by the email and it attachments.

In the Policies tab, you can discover

L s more information about what caused a

“1 Alert rmore]| Dreach of policy. Click More/Less to
Alert display/hide details of each policy as
=] Hidden PDF Data Policy [ Less | required.

Clean Policy.

Based on the following routing:
To Bxternal Recipients

The following has triggered the policy:
Cleans PDFdocuments ofhidden data.

Why is this important?

Go to Summary

Other Tabs

The Office Metadata tab is included in the Email Security dialog when a Clean or
Lightspeed Clean action is triggered for an Office file. Refer to Cleaning Hidden Data
from Attachments, for more information.

The PDF Metadata tab is included in the Email Security dialog when a PDF Clean
action is triggered for a PDF file. Refer to Cleaning Hidden Data from Attachments, for
more information.

The Convert to PDF tab is included in the Email Security dialog when a PDF action is
triggered. Refer to Converting Attachments to PDF, for more information.

The ZIP Options tab is included in the Email Security dialog when a Zip action is
triggered.

The Secure File Transfer Action tab is included in the Email Security dialog when a
Secure File Transfer profile is selected in the Protect Profile dialog. Refer to Secure File
Transfer Profiles.
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Resolving Blocked Emails

Every time you send an email with an attachment, Workshare Protect checks the
attachment to see if it breaches any security policies in the default profile.

Your system administrator can define policies that block any attempt to send emails
containing certain pre-defined policy triggers. An attempt to send an email or
attachment that contains one of these policy triggers results in the email being blocked.
If an email is blocked, the conditions that caused it to be blocked (content, attachment,
or recipients) must be removed before the email can be sent.

When you send an email that triggers a Block action, Workshare Protect notifies you
that your email has been blocked.

r R
Workshare Protect - Advanced Email Security Opticns M
. (=) Workshare
Summary | Policies
Select File ° BLOCKED
Select Al Actions This email contains a restricted attachment This email cannot

be zent. Either remove the attachement or de-activate the

=| mmEn Medium Risk
——————————————————————————————————————————————————— ) Eul Document Restriction Policy

restriction,
Triggered Policies

Test GSG 3.docx

Help

To resolve blocked emails:

1.

Click the name of the policy in the Triggered Policies list or select the Policies
tab to view what content has triggered the email policy.

Click the Close button to close the Email Security dialog.

Make the appropriate changes to the email and/or document(s) by removing or
modifying the content, attachments or recipients that caused your email to be
blocked.

. If making changes to attachments, re-attach the corrected documents.
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5. Click Send. If you have made all the relevant changes, you should now be able

to send the email successfully.

Reviewing Alerts

Every time you send an email with an attachment, Workshare Protect checks the
attachment to see if it breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy
triggers that alert you to content risk in emails and documents when they are sent by
email. The Alert action provides information about content or attachments that might
violate policy, but does not require that the content be removed before sending the

email.

When you send an email that triggers an Alert action, Workshare Protect notifies you
that your email and/or attachment(s) contain content risk.

-
Workshare Protect - Advanced Email Security Options

9 |

Summary | polices

mEEs Medium Risk

B Original Test UG.docx
-| mmEs Medium Risk

Select File Apply Action
Select Al HETE }K__J Metadata Removal
message subject/body emove Comments

Skip Office Metadata Cleaning
|| Skip PDF Metadata Cleaning

_@ Workshare Secure PDF
[] Convert to PDF

Triggered Policies
ﬂ Alert

Help

View Risk Report

send il Cancel l

To find out more about what triggered a policy, click the name of the policy in the
Triggered Policies list or select the Policies tab. The Policies tab is displayed
showing the policies triggered on the right side. Click More/Less to display/hide details
of each policy as required. If required, you can make changes to your email or the

attached documents to take account of the content risk discovered.

When you are ready to send the email, click Send.
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Cleaning Hidden Data from Attachments

Every time you send an email with an attachment, Workshare Protect checks the
attachment to see if it breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy
triggers that oblige you to clean hidden data from attached documents when they are
sent by email. The Clean, Lightspeed Clean and PDF Clean actions remove hidden
data, such as track changes, hidden text, comments, markup and more, from
attachments.

Lightspeed cleaning is much faster than regular cleaning because it maintains the
original structure of the document and redacts hidden data which might contain
sensitive information. Regular cleaning actually removes the hidden data element from
the document. With Lightspeed cleaning, formatting track changes which pose no risk
are left intact. For a detailed description of what is cleaned using each method of
cleaning, refer to Appendix C: Clean and Lightspeed Clean.

When you send an email that triggers a Clean, Lightspeed Clean or PDF Clean
action, Workshare Protect notifies you that your email and/or attachment(s) will be

cleaned.
r R
Workshare Protect - Advanced Email Security Options M
Summary | policies | Office Metadata | Convert to POF | PDF Metadata |
Select File Apply Action
Select Al Actions }K—J Metadata Removal
-~ message subject/body Iﬂ Remove Comments
l—'z—] [ 1] Medium Risk [] Remove Track Changes
- S Cleanne
Plans.pdf [ 1 skip Office Metadata Cleaning View Options
R Medium Risk [ skip PDF Metadata Cleaning View Options
CLEAN
. Modified Test UG.docx =iz Workshare Secure PDF
| g sk 9
_______________________________________________________ [7] convert to PDF View Options
- CLEAN
. TestGSG.docx BTN . .
— | mmmm High Risk Trllggered Policies
------------------------------------------------------- ] Alert
] Hidden POF Data Policy
1_';:‘_] Document Conversion Policy
] Hidden Data Policy
More Palicies
Help View Risk Report Send I [ Cancel ]

Note: For more information on the types of hidden data contained within Microsoft
Office documents, see Cleaning Options.
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If your administrator has enabled you to override the clean hidden data settings and you
do not want to clean the attachment(s), you can select the Skip Cleaning checkbox (or
either of the Skip Office Metadata Cleaning or Skip PDF Metadata Cleaning
checkboxes individually) in the Apply Action area.

To clean hidden data:

1. Select the attachment in the Select File list to specify individual options for a
single attachment or select the Select All checkbox to select all attachments.
Any settings will then be applied to all attachments.

2. Click View Options in the Metadata Removal area or select the Office
Metadata tab. The Office Metadata tab displays the different hidden data
cleaning options for Microsoft Office attachments.

i ™y
‘Workshare Protect - Advanced Email Security Options M
| Summary | Policies || Gffice Metadata | convert to POF | PDF Metadata |
Select File Apply Action
Select all Actions Office Metadata
Select the metadata types to be removed from the attachment(s).
= message subjectibody [¥] Apply Action
i —
------------------------------------------------------ [ High Risk Elements il
.ﬂ: Plans.pdf €L LA Authors Auto Version
A= mEEE Medium Risk [] Comments Hidden Text
------------------------------------------------------ [C] small Text [ Track changes
(W] 5 Modified Test UG.docx | CLEAN | Versions [ wihite Text
=| mmmm HighRisk £
______________________________________________________ Medium Risk Elements
5 Test G5G.docx KA Custom Froperties Document Variables
l mEEE High Risk Ink Annotations Macros
...................................................... Reviewers Routing Slip

[H| Low Risk Elements
Built In Properties Document Statistics b
Go to Summary

o .

3. Select the hidden data that you want to remove by selecting or deselecting the
relevant checkboxes.
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4. Click View Options in the Metadata Removal area of the Summary tab or
select the PDF Metadata tab to display the different hidden data cleaning
options for PDF attachments.

I ™y
Workshare Protect - Advanced Email Security Cptions M
(=) Workshare
Summary | Policies | Office Metadata | Convert to PDF PDFMEEdEE|
Select File Apply Action
e o e —

Select the metadata types to be removed from the attachment{z).
— Mmessage subject/body

B e Removal of Properties will invalidate PDF/A status.

e 7] Apply Action
- Plans.pdf | CLEAN |

A= mEEe Medium Risk High Risk Elements
""""""""""""""""""""""""""""""""" Markups
z Modified Test UG.docx
| wmmm High Risk Medium Risk Elements
""""""""""""""""""""""""""""""""" Attachments [] Properties

wy Test GSG.docx
[==| wmmm High Risk Low Risk Elements
""""""""""""""""""""""""""""""""" Bookmarks

Go o Summary.

o m e

A

5. Select the hidden data that you want to remove by selecting or deselecting the
relevant checkboxes.

Note: The availability of these options is dependent on whether your
administrator has enabled you to override the cleaning options in the policy
settings. Refer to your system administrator if you need to override these
settings and they are disabled.

6. Repeat for additional attachments if required.
7. Click Send to send the email.

Workshare Protect cleans the hidden data from the attached document(s) according to
your settings before sending the email.
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Converting Attachments to PDF

Every time you send an email with an attachment, Workshare Protect checks the
attachment to see if it breaches any security policies in the default profile.

Your system administrator can define policies that contain certain pre-defined policy
triggers that force you to convert documents to PDF when they are sent by email. This
prevents the document from being edited, ensuring that its formatting remains intact.
Additional security features enable you to prevent recipients from printing, editing,
copying from or adding comments to the PDF attachment.

When you send an email that triggers a PDF action, Workshare Protect notifies you that
your attachment(s) will be converted to PDF.

- - . —- T - -
Workshare Protect - Advanced Email Security Options l“ﬂ-u
i A — —
(=) Workshare
ary | Policies | Office Metadata | Convert to PDF | POF Metadata |
Select File Apply Action
Select Al Actions }R_J Metadata Removal
A System Requirements.docx -E_ Remove Comments
= | mmmE High Risk Remove Track Changes
---------------------------------------------_- ------ D Skipﬂlear‘lir'lg
7y Sample Original Document.doc = ror | [T] skip Office Metadata Cleaning View Options
HEEE - Medium Risk [T skip POF Metadata Cleaning View Options
@ -] Sample Modified Document.doc ror | = Workshare Secure PDF
— | me=s Medium Risk @ : ;
______________________________________________________ Convert to PDF View Options
| CLEAN |
| ~ Sample Original Document - Sample M... . .
| mmmE Medium Risk Triggered Policies
|| T P ST e ST ‘::-j Document Conversion Palicy
Help View Risk Report [ send || conce |
Ll
o J

If your administrator has enabled you to override the PDF settings and you do not want
to PDF the attachment(s), you can deselect the Convert to PDF checkbox in the Apply
Action area.
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1. Select the attachment in the Select File list and click View Options in the
Workshare Secure PDF area or select the Convert to PDF tab. The Convert
to PDF tab displays the different PDF security settings available.

r > » —_— [ = = ™
‘Workshare Protect - Advanced Email Secunity Options ‘ &u
i A —— e o
(=) Workshare
summary | Polices | Office Metadata || Convert io POF | pDF Metadata |
Select File Apply Action
Select Al Actions Convert to PDF
Select one or more of the security options to to the PDF,
N . s i
@,{, System Requirements.docx e Apply Action
[==| mmmE High Risk
______________________________________________________ D Prevent printing
| CLEAN | Y
9 Sample Original Document.doc e [T Prevent editing of text
=| =R Medim Risk [] Prevent the copying of text and/or araphics
CLEAN Prevent comment being added
- Sample Modified Document.doc E E‘ i
=1 mw=e Medium Risk Password protect the open file:
______________________________________________________ R d (Opti .
I - Sample Original Document - Sample st i Optioal) :
L L L } Confirm password
"""""""""""""""""""""""""""" [T Reconstruct Hyperlinks
[] POF/A
Go to Summary

Help

[ send || concel |

Note: You can specify individual PDF settings for each attachment or select the
Select All button.

. Select one or more of the following security options:

= Prevent printing to prevent recipients from printing the PDF document.
= Prevent editing of text to prevent recipients with Adobe Distiller from editing

the PDF document.

= Prevent the copying of text and/or graphics to prevent recipients from
copying graphics or text directly from the PDF document.

= Prevent comments being added to prevent recipients with Adobe Distiller
from adding comments to the PDF document.

Note: Highlighting text and adding a strikethrough in a PDF is not considered
editing the text. If you want to prevent users doing this, select Prevent
comments being added as well as Prevent editing of text.

in the relevant fields.
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4. If required, select the Reconstruct Hyperlinks checkbox to preserve standard
URL and bookmark hyperlinks.

Note: Selecting the Reconstruct Hyperlinks option can increase the time it
takes to create a PDF document. Hyperlinks that are preserved using this
option may not correspond exactly to the location in the original document.

5. Select the PDF/A checkbox to convert the attachment to PDF/A.
6. Repeat steps 2 to 5 for additional attachments if required.

7. Click Send to send the email.

Workshare Protect converts the attachments to PDF or PDF/A and applies your settings
before sending the email.

SENDING LINKS TO YOUR FILES

Your administrator may have configured Protect to automatically convert your
attachments to links according to attachment size or using a shortcut in the attachments
bar.

Links Shortcut

Whatever the Protect user experience set up in your environment, when you have a
shortcut on the attachment bar, you can convert your attachments to links in a single

click.
The configuration required for this option is in the Workshare Configuration Manager as
follows:

Category Parameter Default

Protection > Sharing Display Link on attachments bar | Not selected

Whenever you add attachments to an email, the Link option is displayed in the
attachments bar.

To
=1

Send

0

Subject | |

Attached Samgle Modified Document.doc (34 KBI; Samnle Original Document.doo (34 KB

Link
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Click Link and your attachments are converted to links and appear in the body of your

email.
| e | |
= - 1 |
Send — -
|
|

Attached | & sample Modified Document.xhtm {536 Bl; = Sample Original Document.xhtml {533 B]

|
Subject |

W Manage permissions = [«

I've shared files with you:

Sample Modified Document docx
i 343 Kb

Sample Original Document docx =
34.0 Kb

View the files

Note: If required, click Manage Permissions in the attachments bar and change the
permissions set for your files, such as whether recipients can download the files.

i)

The attachments are uploaded into a single folder in your Sent folder in Workshare and
in the recipients’ Received folder. The name of the folder is whatever you enter in the
Subject field.

The folder is created as soon as the attachments are converted to links and if you look
in Workshare before you click Send, you will see the folder and the names of the files
with upload pending.

B Sent Send for Review

@ Y Find |
£ Uploading 2 files sent by email w
ﬂ_| Sample Criginal Document.docx Uploading pending...
'Ei Sample Modified Document.docx Uploading pending...

Once your email is sent, the files are uploaded to Workshare. The recipients will receive
your email straightaway and they can click the file names or the View the files button to
view the files in Workshare. If the files are still uploading, upload pending is displayed.
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Large Attachments

In order to avoid blocking email with large heavy files, you can upload the files to
Workshare and send recipients a link to those files. There are several ways this can be
done depending on your configuration.

Auto Convert

The configuration required for this option is in the Workshare Configuration Manager as

follows:
Category Parameter Default
Protection > Sharing Automatically convert to link(s) No size specified

when total attachment size
exceeds (MB)

If a limit has been set for this parameter, as soon as you attach files above this limit,
they are automatically converted to links.

The links appear in the body of your email and the attachments are uploaded into a
folder in Workshare.

Attach as Link Button

The configuration required for this option is in the Workshare Configuration Manager as
follows:

Category Parameter Default
Protection > Sharing Display Attach as Link button Selected
(Outlook)

When auto convert is not set up and your administrator has set a limit on attachment
size (to avoid large files blocking Exchange), when you try and add a file with a size
over the specified limit, Microsoft Outlook displays a message such as:

. B
Microsoft Outlook e |

| i ‘i The attachment size exceeds the allowable limit.
In this case, you can use the Attach as Link button to save the large file to a folder in
Workshare and send recipients a link to the location.

The procedure will vary depending on the Protect user experience set up.
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When Interactive Protect is configured:
1. Click Attach as Link.
2. Browse to the file you want to send.
3. Click Open. A link to the file appears in the body of your email.
4. Repeat steps 1 to 3 to add further files.

Once your email is sent, the files are uploaded to Workshare. The recipients will receive
your email straightaway and they can click the file names or the View the files button to
view the files in Workshare. If the files are still uploading, upload pending is displayed.

When the Protect Profile dialog is configured:
1. Click Attach as Link.
2. Browse to the large file you want to send and click Open.

3. Add the recipient and message details and click Send. The Protect Profile dialog
is displayed with only the Secure File Transfer profiles available.

(=) Workshare

Choose an Email Security Profile

Select security profile you wish to apply to your email

/ Clean & Secure File Transfer
Aftachments are uploaded to Workshare Online and sent as a link.
Secure File Transfer
Attachments are uplooded to Workshare Online and sent as o link.

Advanced Options

4. Select the required Secure File Transfer profile and click Send.

The large file is uploaded to a folder in your Sent folder (in Folders) in Workshare. The
name of the folder is whatever is entered into the Subject field of the email. The

recipient receives an email notifying them that file has been uploaded to Workshare
online and providing a link to the file.
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Auto Select Convert to Link

The configuration required for this option is in the Workshare Configuration Manager as
follows:

Category Parameter Default

Protection > Interactive | Automatically select ‘Convertto | No size specified
Protect link’ when total attachment size
exceeds (MB)

If a limit has been set for this parameter and you have Interactive Protect configured,
when you attach a file over the specified limit, the Replace all attachments with a link
checkbox in the Convert to link area is selected when the Interactive Panel displays.
Simply click Apply, complete your email and click Send and your large file will be
uploaded to a folder in your Sent folder (in Folders) in Workshare. The recipient
receives an email notifying them that file has been uploaded to Workshare online and
providing a link to the file.
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CHAPTER 4. WORKING ONLINE

This chapter describes the Connect element of your installation which brings the online

secure file sharing, collaboration and storage features of Workshare to your desktop. It
includes the following sections:

e Overview, page 75, introduces the online functionality available with Workshare.

e Syncing local files, page 75, describes how to use the Workshare desktop app
to sync content between your desktop and Workshare online.

o Getting content online, page 89, describes how to share files to Workshare
groups from open Office documents and using right-click options
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OVERVIEW

With File Share & Sync included in your installation, you can add your files to the
secure Workshare online platform. Once there, you can access your files from
anywhere and share them securely with people inside or outside your organization.

Workshare integrates with Windows Explorer so you can save and organize your files in
local folders that function seamlessly on your hard drive, but automatically synchronize
with Workshare online. Workshare also integrates with Office so you can share for
review, for example, from right inside Word.

Workshare is available online through a browser at my.workshare.com. Content is
divided into different areas to suit your needs:

Folders Use Folders to publish files and make them available to others.
Within Folders, use My Files to store your own private files that
you don’t want to share with anyone but you want easy access
to from anywhere.

Groups Use groups as workspaces where you can collaborate on files
with people inside and outside your company.

Workshare integrates its save and share functionality into your familiar working
environment:

e Using the Workshare sync folder on your desktop, you can save and share any
files to all areas of Workshare online

e From open Office documents, you can save files to My Files in Workshare and
share files into Workshare groups

e From your desktop, you can right click any file and share it to a group in
Workshare

In order to access and use Workshare online, you must have a Workshare account.

SYNCING LOCAL FILES

The Workshare sync folder is your local access point to the online services of
Workshare. Both the Workshare sync folder and the synchronization functionality are
provided by the Workshare desktop app.
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What is the Desktop App?

With File Share & Sync included in your installation, the Workshare desktop application
(the desktop app) is installed. This is an application that syncs content between
Workshare and your PC so you can access your files and continue collaborating from
your desktop while offline. The key features of the desktop app are as follows:

e Synchronization - Synchronizes groups, folders and files between Workshare
and your desktop. You can be selective about what is synchronized to reduce
the storage footprint on your local machine. If you can’t work online, as soon as
you’re back online, the new versions are uploaded right away.

¢ Integration - Integrates Windows with Workshare online linking Workshare
directly to everyday applications — users can save files directly into the
Workshare sync folder from where they are copied into Workshare online.

Launching the desktop app for the first time

The desktop app is launched once the Protect 9 installation is complete.

File View Help

(=) Workshare

Welcome, let's get started
Enter your email address to sign in or register

[Emiail address

The installation of the desktop program places an icon in your Windows taskbar for
basic management and it puts a folder in your Favorites section in Windows Explorer,
S0 you can quickly access and save your Workshare content. In order to access and
use the desktop app, you must log in to it. You only need to perform this login once; in
future the desktop app will launch automatically when Windows starts. You use your
Workshare login credentials to log into the desktop app.

To log in to the desktop app for the first time:

o When the desktop app launches after installation, enter the email address and
password you used to sign up for Workshare and click Sign In.
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Note: You can also display the login page by clicking the Workshare icon on
your desktop or selecting Programs > Workshare Desktop > Workshare from
the Start menu.

The Workshare desktop app looks very similar to Workshare online accessed from a
browser.

In fact, from the desktop app, you can do all the things you can do when logging into
Workshare online through a browser.

Once you have logged in:

e Your files and folders from your online Workshare account start to synchronize
to your local Workshare sync folder

e The desktop app icon appears in your system tray

Workshare Sync Folder

The Workshare sync folder is your local access point to your online Workshare content.
You can always find the latest copy of your Workshare files and you can add files to
Workshare via the sync folder. It appears in your Favorites folder and its default location
is C:\Users\[user name]\Workshare. You can change the location of the Workshare
sync folder in Preferences > Sync Settings, described on page 120.

You can also click Open Workshare Folder from the desktop app main window.

|
X
GO < ’Cj » Helen Sagal » Workshare-HelenSagal » v | 5 | l Search Workshare-HelenSagal O l
File Edit View Tools Help
Organize ¥ Include in library v Share with v New folder §= « [l 0
s *  Name Date modified Type Size
& Downloads @ Files & Folders (Classic) 22/10/2015 16:55 File folder
] Recent Places | (® GroupFiles 22/10/2015 16:55 File folder
Bl Desktop i My Files 22/10/2015 16:55 File folder

=) Workshare

4 Libraries
3 Documents
Jﬁ Music
(= Pictures
# videos

' 3 items
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In your Workshare sync folder, you will see all your synchronized Workshare files and
folders, grouped as follows:

o Files & Folders (Classic): Includes any shared or unshared files/folders you
had in Workshare before groups were introduced. They have exactly the same
folder structure and permissions as before and you can still view files, download
files and upload new versions. In Workshare online, Files & Folders (Classic) is
now called Folders.

e Group Files: Includes folders with the same names as the groups you’re sharing
in Workshare. In each group folder, you'll see the files and folders shared in the
group. You can add to, update or delete these files and folders, and everyone in
the group will see the changes.

e My Files: Includes all private files and folders you’ve stored in Workshare. You
can add files here if you want to work on them but don’t want to share them and
you can edit, move or delete them — it won’t affect anyone else. In Workshare
online, My Files is under Folders.

If you add, update or delete a file in your Workshare sync folder, it will be added,
updated or deleted in Workshare online too. Similarly, if you add, update or delete a file
in a synced folder in Workshare online through the web app on a browser, the changes
will be seen in the Workshare sync folder.

The icon to the left of a file/folder indicates its sync status:
6? Waiting to be synchronized or synchronization is in progress
S Synchronized

In this two-way file synchronization, updated files are copied in both directions, usually
with the purpose of keeping the two locations identical to each other. You can control
what is synced from your desktop just by adding or replacing files in your Workshare
sync folder. Careful, though because anything you remove from your Workshare sync
folder will also be removed from your Workshare online content.
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Default Sync
By default, the following files are synchronized:
o Files you add to My Files
o Files you add to a shared folder or a group that you own
o Files others add to a shared folder or a group that you own

You can select which folders to sync using the selective sync option. Refer to Selective
Synchronization.

System Tray Icon Menu

Whenever the desktop app is running, its icon E is displayed in the System Tray. The
icon indicates the status of the desktop app as follows:

Icon Status Description

h] Synced The files in your local Workshare desktop folder are fully
synced you’re your online Workshare content.

& Sync in The files in your local Workshare desktop folder are

progress currently syncing with W your online Workshare content.

T Pause Synchronization between your local Workshare desktop

- folder and your online Workshare content is currently
paused.

&] Conflict There is a conflict between files in your local Workshare
desktop folder and files in your online Workshare content.

m Upgrade An upgrade is available for the Workshare desktop app.

V:J Offline The desktop app has been placed offine so no

synchronization can occur.
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Clicking the icon displays the following options:

Option

Open Workshare
App

Open Workshare
folder

View online

[sync status]

Conflicts (#)

Pause

Refresh

Recycle Bin

Selective Sync...

Preferences...

Help and support
Update

What’s new

Exit

Description

Opens the Workshare desktop app.
Opens the Workshare sync folder.

Opens my.workshare.com.

Reports on the current state of synchronization. For example,
“checking”, “Syncing 5 files” or “All files and folders are up to
date”.

If conflicts exist after syncing, the number of conflicts is shown
in parentheses. Click this option to see the Sync Conflicts
page where you can resolve the conflicts. Refer to
Synchronization Conflict.

Pause synchronization. The option becomes Resume when
synchronization is paused.

Refresh the display and synchronize with Workshare online.

Provides access to the recycle bin in Workshare
(my.workshare.com) where you can restore files accidentally
deleted. Refer to Restoring Deleted Files.

Enables you to select which folders are synchronized between
your desktop and Workshare online. Refer to Selective
Synchronization.

Enables you to change application settings for the desktop
app, such as the location of the sync folder or general account
settings.

Provides access to the Workshare knowledge base.

Displayed if updates available. Updates the desktop app to
the latest version.

Displayed if updates available. Provides information about
what’s in the latest version of desktop app.

Closes the desktop app.
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Adding Files to Workshare via the Sync Folder

You can add most file types to your local Workshare sync folder which will then be
synchronized with your Workshare online account. You can add files to existing groups
or folders or create new folders. You cannot create new groups from within the sync
folder.

Note: Groups are created in Workshare from the web app or the desktop app.

You can simply copy/paste or save files into your local Workshare sync folder and they
will be synchronized to Workshare online by default. However, if you have selected that
specific folders do not synchronize then files added to those folders will not be
synchronized. Refer to Selective Synchronization.

To copy/paste to your local Workshare sync folder:

Drag the files or folders you want to add into your local Workshare sync folder.

mv|c_'] » Helen 5agal » Workshare » v|"f|

File Edit View Took Help

Search Workshare

Organize * Include in library = Share with + MNew folder =~ [ @
Atk tade *  hame : Date modified Type
4 Downloads @ Files & Folders {Classic) 19/08/201512:19 File folder
"l Recent Places 'Z':t':':j] Group Files 18/08/201516:38 File folder
B Desktop g My Files 18/08/2015 17:00 File felder
I 5 Workshare o desktop.ini 18/08/201511:28 Configuration settings
4 Libraries =i : C
P @ Documents @
3 J’ Music .
b (] Pictures _ I-? Move to Workshare |
b B Videos

4 items
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To save files to the Workshare sync folder:

1. Open a file — this can be any file, for example, a Word file, a PowerPoint
presentation or an image file.

2. Click Save As.

3. Browse to your Workshare sync folder in Favorites. By default this folder is
located at Users\[user name]\Workshare.

4. Browse to a location in any of the 3 areas in Workshare and select an existing
folder or create a new folder.

5. Click Save. Your file is now saved in your local Workshare sync folder and it is
immediately synchronized to Workshare online (unless the selected folder is not
set to synchronize).

Files won’t sync from here...

o Files added to the top level “Workshare” folder in your local sync folder will not
be synchronized. Files must be added into one of the three areas of Workshare
— Files & Folders (Classic), Group Files or My Files.

o New folders added to the Group Files area will not be synchronized — Groups
can only be created via the web app.

In either of the above scenarios, the icon next to the file B and a popup message alert
you that the file/folder cannot synchronize to Workshare.

{ Your file is not placed in a folder that syncs to
Workshare

Move it to & group folder or 'My Files' to syncit.

View

Clicking View opens the non-syncing folder locally so you address the problem.

Restoring Deleted Files

From your desktop, you can access the online Workshare recycle bin where you can
restore any of your accidentally deleted files or folders. The recycle bin lists all your
Workshare files and folders (those you own and those that others have shared with
you) that have been deleted from Workshare — you may have deleted them from within
Workshare (using a web browser) or directly from your local Workshare sync folder.
Restoring them from the Workshare recycle bin ensures that any comments and
versions are also restored with the file.
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Note: When you have deleted files and folders from your local Workshare sync folder,
you will only see the deleted files and folders in the online recycle bin after
synchronization.

The desktop app provides a window into the online Workshare recycle bin so if you are
offline, you will not be able to access the recycle bin.

To access the recycle bin:

Click Recycle Bin in the left navigation bar in the desktop app (or click Recycle Bin in
the system tray icon menu).

The Workshare web app is displayed in a browser window with the Recycle Bin page
open.

e
File View Help
Search Q > Open Workshare Folder Helen Sagal @ v
Name A Parentfolder | Deletedby | OwnedBy | Deletion date
(33] ® Deleted by me
Deleted by everyone else ’ Sent Files Helen Sagal Helen Sagal 1 year ago

» [ 07/10/2015 14:18:57 Sent Files Helen Sagal Helen Sagal 2 weeks ago
» [ 09/09/2013 14:05:19 Sent Files Helen Sagal Helen Sagal 1 year ago
» (] 18/08/2015 11:03:44 Sent Files Helen Sagal Helen Sagal 2 months ago

9a93412e-adbe-11e3-8fa4-0200 \ Helen Sagal Helen Sagal 7 months ago
4 a92eee2c-5bda-dedd-87ba-5bd4d \ Helen Sagal Helen Sagal 5 months ago
| ] Archive.zip \ Helen Sagal Helen Sagal 2 years ago
» b7f6d69d-92cc-4203-b5ff-c9642... |
¥

baa92b45-81d6-11e3-aa25-0200

Helen Sagal Helen Sagal 5 months ago

Helen Sagal Helen Sagal 5 months ago

» ] big test Sent Files Helen Sagal Helen Sagal 2 months ago
» Blooooood \ Helen Sagal Helen Sagal 4 months ago
m » brand new \ Helen Sagal Helen Sagal 4 months ago
Recycle Bin = ¢95039¢4-8db2-11e3-aa25-0200... \ Helen Sagal Helen Sagal 7 months ago
» [ Case # 456345506 Sent Files Helen Sagal Helen Sagal 1 year ago
] Comments Roadmap.docx Work in Pro. Helen Sagal Helen Sagal 2 months ago
|] Comp Ver. Silent video Helen Sagal Dave Ewart 1 year ago
¢ Comparing Versions.mov Silent video Helen Sagal Dave Ewart 1 year ago
» [ Copy of Sample Original Docu Sent Files Helen Sagal Helen Sagal 1 year ago
8 Crib Sheet - Implement Change... Pro 9 Helen Sagal Ainsley 11 months ago v

In the Recycle Bin you can see a list of all Workshare files and folders owned by you or
shared with you by others, that have been deleted from Workshare. You can filter the
list to see what was deleted by you and what was deleted by others.

o Click Restore All to restore all files and folders in the recycle bin back to their
original location.

o Click Empty Recycle Bin to permanently delete all files and folders in the
recycle bin.
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To restore selected files:

1. In the Recycle Bin, select a file or a folder (or several files and folders) by
selecting the checkbox to the left of the name. The buttons change to Restore
Selected and Empty Selected.

Recycle Bin -
Y () Workshare
Deleted files and folders
Show Me

© Deleted b O  Namea Parent folder Delet B Deletior

eleted by me

O Deleted by everyone eise o> Sent Files Helen Sagal Helen Sagal 8 months ago
M » [ 09/09/2013 14:05:19 Sent Files Helen Sagal Helen Sagal 8 months ago
[m]
A

9a93412e-adbe-11e3-8fa4-02001f... \ Helen Sagal Helen Sagal 2 months ago

ChAn Andd QTha ChAA2E | Halan Qanal  Halan Qanal 1 manth ann

2. Click Restore Selected to restore the selected folders and files.

File Synchronization

The desktop app synchronizes your online Workshare content to your PC so you can
access your files and continue collaborating when offline. By default, the following files
are synchronized:

e Files you add to My Files
e Files you add to a shared folder or a group that you own

o Files others add to a shared folder or a group that you own

So if files are added in these ways to Workshare online via a web browser, they will be
synced to your desktop and you will be able to access them in your Workshare desktop
app or the local Workshare sync folder. Similarly, if files are added to your Workshare
desktop app or local Workshare sync folder, they will be synced to Workshare online.
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Synchronization occurs automatically as follows:
o When logging into the desktop app

¢ When a new event occurs online, such as a new file uploaded or a new version
added

e When a new event occurs in your local Workshare sync folder, such as a new
folder created or a file added

e When the desktop app has been offline and then you go back online
e When clicking Reload in the View menu in the desktop app

e When clicking Refresh in the desktop app system try icon menu

e When clicking Q| in the Sync Progress report

e When clicking Update and Sync in the Selective Sync page

You can pause synchronization at any time, for example, if you have a slow connection,
and then restart it when convenient.

To pause synchronization:
Click the desktop app system tray icon and select Pause. Synchronization stops.

To restart synchronization, click the desktop app system tray icon and select Resume.

Selective Synchronization

You can modify the default synchronization settings so that less files and folders are
synchronized to your desktop in order to reduce the storage footprint on your local
machine.

To select folders to synchronize:

1. From the File menu in the desktop app, click Selective Sync (or click Selective
Sync in the system tray icon menu). The Selective Sync page is displayed.

2. Click a folder to display its subfolders.

3. Select the folders that you want to synchronize between your online Workshare
account and your desktop by selecting the checkbox to the left of the
folder/subfolder name. Selecting or deselecting a folder will automatically
select/deselect the subfolders belonging to the folder. However, you can select a
folder but then manually deselect some of its subfolders. Use the Select All
checkbox to quickly select/deselect all folders.

Note: By default when a folder or group is shared with you it is selected for
synchronization. To change this, deselect the Automatically sync new folders
shared with me checkbox.
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4. Click Update and Sync. All folders with a selected checkbox will be

synchronized.

Folders that are not synchronized will not appear in your local Workshare sync folder.

Sync Progress

The Sync Progress report shows the folders and files currently being synchronized.

To display the Sync Progress report:

From the View menu in the desktop app, click Sync Progress (or click the sync status
option in the system tray icon menu — could be “Checking”, “Syncing 5 files” or “All files

and folders are up to date”).

| ) Workshare Sync Progress E]j
User name, file name, type or folder [=ARNANE o ]
Name Folder Size Proﬁres Last Updated By =
E_'] WS Compare 8 Release Notes.docx Release Notes 109 KB LWWW 100% 1 Count Sagalovicl
E_I] WS Professional 8 Release Notes.docx Release Notes 129 KB Count Sagalovicl
@)  war and Peace.docx File Share 14 MB : Helen Sagal
®  sample Original Document.png Release Notes 177 KB C oot 100%. ] Ainsley ]
@_] WS Protect 8 Release Notes.docx Release Notes 109 KB L ok 100% 4 Ccount galovicl
'@ WS Compare 9 UG.pdf new 4 MB .Wa/mgmsym 0% Helen Sagal
'@ WS Professional 9 Release Notes.pdf new 907 KB 0% J Ainsley I
@ WS Compare 9 Release Notes.pdf Pro 9 Update 1 PDFs 705 KB Dom 0% J Helen Sagal
@ WS Compare 9 UG.pdf Pro 9 Update 1 PDFs 4 MB :WanSm 0% J Helen Sagal
@ WS Pro 9 Installation Guide.pdf Pro 9 Update 1 PDFs 2MB Dom)‘oaohg 0% ’ Helen Sagal
T Ws Pro 9 Instalation Guide.pdf new 2m8 mm 0% ] Ainsiey
L ws Protect 9 UG.pdf Pro 9 Update 1 PDFs 3M8 L 0% ' Helen Sagal
@ WS Professional 9 UG.pdf new 6 MB lr 1% Ainsley -
< [
() | syncing - 20 fies remaining

The status bar provides a summary of the sync situation and the Sync Progress report

provides a detailed view.

The files being synchronized are shown in a queue format. If you want to move a file in
the queue, for example, you want to upload a small Word document and it is being held

up by a large PowerPoint presentation, right-click the file you want to delay and select

Lower the sync priority.
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Synchronization Conflict

The Sync Conflicts page provides a dedicated area where you can deal with file
conflicts. Possible conflict scenarios include:

e You have opened a synced file locally and you are editing it. Meanwhile, in the
web app, a new version is added to the file. When you save the open file, a
conflict is shown.

e Two users are working offline and make changes to a file they share. User 1
goes back online and the revised file is synced to Workshare online as a new
version. User 2 goes back online and a conflict is shown.

In your local Workshare sync folder, the file icon shows there is a conflict:

8_] Sample Changed Modified Document.do...
] Sample Modified Document.docx
@] Sample Original Document.docx

In addition, the desktop app system tray icon shows there is a conflict and the
menu includes a Conflicts option:

£ Open Workshare folder

&>  View online

q date

Refresh

Recycle Bin

Preferences...

Help and support

O
w
M  Selective Sync...
&
(2]
D

To resolve a conflict:

1. Click Conflicts in the system tray icon menu. The Sync Conflicts page is
displayed listing the files with conflicts.
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2. Select a file to display the options for resolving the conflict in the right panel.

L) Workshare
Sync Conflicts
Name Date Modified Size Last Modffied By  Owner
© 4 () MyFies Jun 18 2015 Helen Sagal A Resolve sync conflict
© 4 [ Sample Test Folder 10:00 Today Helen Sagal This file has not been synced as there is a confiict file
o) 9:59 Today 118K Helen Sagal___ Helen Saga el s g 9

© Add my file as latest version

unknown
Located on this computer

Q Size:
Modified by: Helen Sagal

Modified on: 5 minutes ago

© Overwrite my file with this version

Sample Original Document.docx
G Located online

Size: 19 KB

Modified by: Helen Sagal

Modified on: 5 minutes ago

© Keep both fies

@ Sample Original Document.docx
L unknown

|EZ2|  The online fie name will include

the user's name.

3. Select how you want to deal with the conflict. For example, you can choose to
keep the local version of the file or the file located online or you can keep both.

Note: Different options are displayed according to the particular conflict.

4. Click Resolve conflict at the bottom of the right panel.

Collaborating in Workshare

Once you have shared folders with other users, those users will be able to access
Workshare via the web app, view the files in the folder and add comments in real-time.
If they have permission, they could also add new versions to a file. Any new versions
will be synchronized to your desktop and you can also add versions to Workshare files
from your desktop through your Workshare desktop app or your local Workshare sync
folder. For example, simply open a file from your local Workshare sync folder, edit it and
save it and it will be synced to Workshare online and appear as a new version.

ample Original Document-Helen Sagal.docx

Version2 « Updated 10:20 Today by Helen Sagal
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You can also open any file and save over a file in your local Workshare sync folder. It
will be synced to Workshare online and appear as a new version.

GETTING CONTENT ONLINE

As well as using your local Workshare sync folder to get your content online, you can
use the right-click options and toolbar options added by the Connect element of your
Protect installation.

Right-Click Sharing

The way to share files and folders from your desktop is to share them to a Workshare
group.

Right-clicking any file on your desktop provides the option to share it to a group. The file
or folder will be added to the group’s files and all members of the group will be able to
access it.

To share to a group:

1. In Windows Explorer, right-click any file or folder.

] Minutes 281 [ Compare with Workshare hon File 08
MND Modifiek _@ Convert to PDF with Workshare h Text Format 04
@j ND Modifie 3 Combine files in Workshare iy e TR f
(1 o origing | INENETET ] < shareto group

[ . =

2. Select Workshare, then Share to group.

= share to group =

This file will be shared with people in:

Enter group name|

Sample Original Document. docx .,,4_7
34KB

i)

89



(=) Workshare RN NeReINHIN

3. Enter the name of the group you want to share the file/folder with. When you
click in the text box, a list of the most recent groups selected is displayed. As
you start to enter a name, groups are suggested to you.

This file will be shared with people in:

Review Material

Create a new aroup: Review Material

4. Select an existing group or enter a new group name and click Create a new
group.

Note: Click Change Group to remove the specified group so you can select
another one.

5. If you want to change the name of the file/folder you are sharing, click ra and
edit the name.

6. Click Share. The file/folder is uploaded to the specified group in Workshare
online. If the group is synced, the added file or folder will also appear in the
selected group in your local Workshare sync folder.

From Open Office Documents

Using Workshare toolbar options, you can save your Office files to Workshare online so
they will be accessible to you online at all times. You can save them directly to a folder
in My Files if they are private files that you don’t want to share with anyone or you can
save them directly to a group if you want to collaborate on them with people inside and
outside your company.

You can save Word, Excel and PowerPoint files in their native format or convert them to
PDF as you save.

Additionally, you can display the Workshare Connect panel inside Office which provides
a window into the document you have shared to a Workshare group.
Saving to My Files

The My Files area of Workshare online is where you can securely store your own
private files that you don’t want to share with anyone but you want easy access to from
anywhere.

90



(=) Workshare [EReLINNEYINHIN=

To save documents to My Files:
1. Open a file in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Save to My Files. The Save to My Files dialog is
displayed.

Note: If you are not already logged into Workshare, you may be asked to log in
before the Save to My Files dialog is displayed.

é Save to Workshar?_ ™ g i s ." E‘M

-] Create new folder

4 O @ MyFies
[ Getting Started

Trial Documents

T Helen Pro 9 Test

File name: Sample Original Document

Save as type: | Word Document %

— =

A==

Tip! You can also display this dialog using Workshare options in the File menu.

3. Browse through My Files and select the folder where you want to save the file.

Note: To create a new folder, click Create new folder, enter a name for the
folder and click Create.

4. In the File name field, modify the name of the file as required.
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5. From the Save as type dropdown list, select the format for the saved file from
the following:
= Word Document/Excel Workbook/PowerPoint Presentation: Saves the file
in its native format
o PDF: Saves the file as a PDF file
o PDF/A: Saves the file as a PDF/A file

6. Click Save. The file is saved to the specified folder in Workshare My Files and
you can log into Workshare and access the file from anywhere. The following
notification pops up on your desktop:

V File saved to Workshare
Copy link View

You can click View to open the file in Workshare in your browser or click Copy
link to copy the URL to the file to your clipboard. You can then paste this link to
another location, for example, an email or an instant message.

If the Workshare My Files folder is synced, the added file or folder will also appear in
your local Workshare sync folder

Once you have saved a file to My Files, you can continue working and making changes
as required. Clicking Save to My Files again will save the file to Workshare with the
same name and in the same location as a new version. If you want to save the file to
My Files as a new file with a different name, click the arrow on the Save to My Files
button and click Save as.
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Sharing to a Workshare Group

By sharing files to Workshare groups, you save your file to a group in Workshare and all
members of that group can access your file and collaborate on it with you.

To share documents to a group:
1. Open a file in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Share. The Share dialog is displayed.

Note: If you are not already logged into Workshare, you may be asked to log in
before the Share dialog is displayed.

€3 Share i l' |

A copy of your file will be shared to:

Enter group name

sample Modfied Document Version 1

40.7 KB

| Share | Cancel

Tip! You can also display this dialog using Workshare options in the File menu.

3. Enter the name of the group you want to share the file with. As you start to enter
the name, groups are suggested to you.

A copy of your file will be shared to:

Kn 0

Knowledge Group ‘

Workshare, 1 members

Create a new group: Kn

4. Select a group or enter a new group name and click Create a new group.
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5. Edit the @me of the document by clicking 4 , modifying the name and then
clicking

6. Click Share. The document is saved to the group in Workshare and a
confirmation dialog is displayed.

&) share S5

©

f File shared |

A copy of Compare Draft Proposal
has been shared in the following group:

Sunset project
p_ . C‘_’) Workshare i

Link to file: &
https://my.workshare.com/#g/invite/d85d8203-4240-11e4-80b2-2200026930F4

If the Workshare group is synced, the added file or folder will also appear in your
local Workshare sync folder

7. Continue in one of the following ways:
= Click Send email to open a new email in Outlook that includes a link to the
document in Workshare. You can invite people to the group by sending the
email to them.
o Click Go to group to open the group in Workshare in your browser where you
can see the document, set group permissions and select members.

Note: Click & to copy the link to the document to your clipboard. You can
then paste this link to another location, for example, an email or an instant
message.

Monitoring Shared Files

The Workshare Connect panel inside Office provides a window into the files you have
shared to Workshare groups.
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When you have shared a document into a group in Workshare and you open the
document locally, the Workshare Connect panel provides a view of what is happening
with your collaboration. You can see the other reviewers (the members of the group)
and whether they are online at the moment. You can also see how many comments
have been made on the document and whether any new versions have been added to
it. With a single click you can open the document in Workshare online via a browser
and join in the collaboration by viewing comments and making your own comments.

If you open a shared document in Office and the Workshare Connect panel is not
displayed, click Toggle Panel in the Workshare tab to display it. When the document is
not shared to a Workshare group, the panel will look something like this:

Workshare Connect - X

Once your document is shared, the Workshare Connect panel will provide real-time
information about the collaboration, like new comments and versions.

Workshare Connect X

A new version has
been uploaded.
Click here to
download it.

r A new version of this document is available. Download
Click the version
dropdown to see
other versions of
the document. Click
a version to display

Sample Modified Document..docx

Version 1 =

The People tab

it in the Workshare Comments People \\ shows the members

web app. \ of this group and
who is reviewing
and editing the

The Comments tab Sersiment

shows the number
of comments made
on the displayed
version as well as
the total number on
all versions.

-y - Q@

Comments on this version

When there are
comments you have
not yet read, click
this alert to display
the document in
the Workshare web
app soyou can
review the

Click here to display Total of 6 on this document

the document in

the Workshare web —

app.

e

comments.
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New Versions

When another group member adds a new version of the document, you are notified in
the Workshare Connect panel. Click Download and the new version is downloaded and
opened. Now the Workshare Connect panel will ask if you'd like to see what’s different
between this new version and the previous version. With a single click, both versions
are compared in Workshare Compare.

Workshare Connect v X

A This document has been updated since you last
A0, opened it. See changes

Sample Original Document.docx

Version 1

Comments People

Comments Added

In the Comments tab, you can see the number of comments made on the version of
the file you are looking at (in orange) as well as the total number of comments on all
versions of the file. If you want to see the actual comment, click View online and open
the file in Workshare via a browser so you can view comments and update versions and
add comments if you want. When comments are made that you have not yet seen, click
the Unread comments alert and the file is opened in Workshare via a browser.

Group Members

In the People tab, you can see all members of the group that have access to your
document. A green light indicates the member is currently viewing the file. The following
three lists are available:

o Everyone: All members who have access to the file
e Reviewers: Any member who has looked at the file

o Editor: A member who has looked at the file in Word (and had Protect 9
installed and the Connect panel turned on)
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CHAPTER 5. ADVANCED PDF
FUNCTIONALITY

This chapter describes how to combine several documents into a single PDF. It
includes the following section:

o PDF Combine, page 98, describes how to combine multiple files into a single
PDF.
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Q PDF COMBINE

Workshare Protect enables you to combine multiple files into a single PDF or PDF/A
file. For example, electronic court submissions are required to be submitted as a PDF
or PDF/A file. Case information can include multiple file formats such as contracts,
financial spreadsheets and email conversations.

Protect supports the combination of the following file types into a single PDF file: DOC,
DOCX, PPT, PPTX, XLS, XLSX, PDF, RTF, TXT, HTML, MSG.

To combine multiple documents into a single PDF:

1. In an open Office document, click Combine PDF (Protect group) in the
Workshare tab or in Windows Explorer or your DMS, right-click one or more files
that you want to combine into a single PDF and select Combine files in
Workshare. (You do not have to select all the files to combine at this stage but
can add them later.) The Combine Files dialog is displayed.

73 Workshare - Combine Files @Elg
l (=) Workshare
Select and arrange the files to combine into a single PDF using the action buttons
| AddEle # || AddFolder + | saveConfiguration |
Name Pane Range Size  Status Pages Range
[ System Requirements All Pages 231k [ ] % Remove
@Annual Report All Pages 1268 KB =
I%Emkl all Pages sk [ [ 4 Move Up l
| ¥ Move Down |
Create PDF version as: [PDF(-pdﬂ '] l Configure PDF Security ]
o [Comen] (G (o)
b -

2. Add the additional files you want to include in the single PDF using the buttons
at the top or by dragging and dropping. Click Add Files to select and add a
single file and select Add Folder to add multiple files from a selected folder.
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3. Once you have selected the files to combine, arrange the order using the Move

Up and Move Down buttons. If you want to remove a file from the list, select it
and click Remove.

4. If you only want to include selected pages from a particular document, select the
file in the list and click Pages Range.

e ==

Select the pages to be induded in the final PDF from the file
listed below.,

file:/(C: fJUsers/helens/Desktop/Original Test UG. pdf

|§:| All

") Pages:

All pages in range -

o) (o)

5. Select the Pages radio button and specify the pages to be included into the
combined PDF as required.

6. Click OK.

7. Select whether you want to create a PDF file or a PDF/A file from the Create
PDF version as dropdown list.

99



SNV ADVANCED PDF FUNCTIONALITY

8. If you want to set security options for the combined PDF, click Configure PDF
Security.
Warkshare T =)

A i

A —

PDF security configuration

|:| Prevent printing
[7] Prevent editing of text
[7] Prevent the copying of text andjor graphics

\ [7] Prevent comments being added
| Metadata cleaning

[7] clean befare POF

. _;I_e;.r!i!_'!g_G_p]j_ms_ 12 option(s} selected |

Password protection

Spedfy a password for the generated PDF. Only users with the |
password can open the document.

Speci?.f- pass'n'or_rfl-

Confirm password

= oy ][ concel |

9. Select one or more of the following security options:
o Prevent printing: Prevents recipients from printing the PDF document.
o Prevent editing of text: Prevents recipients with Adobe Distiller from editing
the PDF document.
= Prevent the copying of text and/or graphics: Prevents recipients from
copying graphics or text directly from the PDF document.

= Prevent comments being added: Prevents recipients with Adobe Distiller
from adding comments to the PDF document.

Note: These options are disabled and cannot be selected if you selected
PDF/A in step 7.
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10. To specify what hidden data to remove before converting it to PDF, select the
Clean before PDF checkbox and click Cleaning Options.

Worksh

.o are - Be— “ . u
Please select the elements you would like to remove from the
batched file list.

Cleaning Elements:

[] Toogle onjfoff

Delete built-in properties (Office) ||
[7] Accept changes and turn off Track Changes (Word and E
[] Delete comments (Office)

Delete hidden text (Word)

[7] Delete white text on any background (Word)

I [ Delete text smaller than Spt (Word)

Delete routing slip (Word and Excel 2003)

Delete custom properties (Office)

Convert field codes to text (Office) ||
[¥] Delete document variables (Word)
Convert attached template to Normal (Word) |
Turn off versioning (Word 2003)
Delete versions (Word 2003) ||
Delete Smart Tags (Word)

[] pelete footnotes (Word)

Delete macros (Word)

Delete document reviewers (Word)

Help [ Back || ok ][ cancel |

11. Select hidden data elements as required. For a full description of all the hidden
data elements, refer to Cleaning Hidden Data for further information.

12. Click OK.

13. If required, set a password to protect the PDF by entering the password twice in
the Password protection area. When a password is specified, the recipient
can only open the PDF after entering this password.

Note: If you selected PDF/A in step 7, you cannot set a password and the
Password protection area is disabled.

14. Click Apply.
15. If required, click Preview to view the combined PDF.

16. Click Create PDF. A Save as dialog is displayed.

17. Specify the name and location for the combined PDF file and click Save. The
documents are converted into a single PDF. The progress of the operation can
be seen in the Status column in the Combine files dialog.
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If you want to save your selection without creating a PDF — for example, if you have not
completed the selection of documents — you can save your work in progress as a
Workshare workbook (.WWB) by clicking Save in the Combine Files dialog. When you
are ready to work on it again, simply right-click the WWB file and select Combine files
in Workshare or drag new files you want to include over the WWB file. This re-opens
the Combine Files dialog and you can continue.

Note: For iManage users, in order to save a Workshare workbook, the WWB file type
needs to be registered as a file type on the Worksite Server.

®Note: If you work with Workshare online, you can also use Save As and save
the combined PDF to your Workshare sync folder and it will be synchronized to
Workshare. Refer to Adding Files to Workshare.
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CHAPTER 6. CONFIGURING
WORKSHARE

This chapter describes the Workshare Configuration Manager. It includes the following
sections:

« Introducing the Workshare Configuration Manager, page 104, introduces the
Workshare configuration utility.

o Accessing the Workshare Configuration Manager, page 104, describes how
to access the Workshare Configuration Manager.

o Setting Parameters, page 106, describes how to set values for parameters in
the Workshare Configuration Manager.
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INTRODUCING THE WORKSHARE
CONFIGURATION MANAGER

The Workshare Configuration Manager is a configuration utility that enables you to
configure Workshare and the way it behaves as well as modify the configuration of the
Client Default profile (via the parameters in the Protection category).

Note: A profile is a collection of policies. A policy is a set of parameters applied by
Workshare Protect when determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

o Administrator Mode: This mode is for administrators to make changes to the
default settings on the local machine. Settings made are saved in
HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access to
Administrator mode if you have Administrator rights.

o User Mode: This mode is for users to make changes to the Workshare
configuration to suit their own personal preferences on the local machine. Other
users could log in and they would not have the same configuration settings.
Settings made are personal to the user and saved in HKEY_CURRENT_USER in
the Registry.

Note: Your system administrator may have restricted the rights of users to modify
configuration parameters by locking individual parameters so that users cannot
override the setting. If you have restricted access rights and have special requirements
for configuration, please speak to your system administrator.

ACCESSING THE WORKSHARE
CONFIGURATION MANAGER

The Workshare Configuration Manager can be accessed from within Microsoft Word or
from the Start menu.

To access the Workshare Configuration Manager from Microsoft Word:

e In Microsoft Word, click Options in the Workshare tab. The Workshare
Configuration Manager opens in User Mode.

104



E LT  CONFIGURING WORKSHARE

To access the Workshare Configuration Manager from the Start menu:

e From the Start menu, select All Programs > Workshare > Workshare
Configuration (User Mode). The Workshare Configuration Manager opens in

User Mode.

‘Workshare Configurati

f:::']Workshare Configuration Manager

=

Launch Administrator Mod. e'@'

Compress as Zip

| b

_ Options  Rendering Set Manager My Products
ﬁ' [ Reset All To Default I [ Apply l || Hide options I cannot change. Search Ccnﬁéura?(o.ﬂ Options Q
=y PN Leor B
Protecti Sl {
HEoad I—‘:Qé ﬁ = & =
Administration Sharing Interactive Protect Remove Metadata Exclude Metadata Convert to PDF
= JEEE—C
— be || [
&
Administration User Interface
o || e
P r
General ’]'W -
!
inistrati User Interface
==
—
Integrations d—l_‘l
General
[ n
Help. Workshare Configuration anzger | Build 3002070 | Copyright S1998-2014 Workehare Lt () Workshare J

Note: In User Mode, the state of the options reflects the settings in

HKEY_CURRENT_USER in the Registry.

The configuration parameters for Workshare are grouped into categories and sub-
categories. Click a sub-category to display the parameters for that sub-category. The
different sub-categories and their parameters are described in a separate guide -

Workshare Configuration Options.

Searching Parameters

If you know the name of a parameter (or part of its name) but not its location, you can
search the Workshare Configuration Manager using the search box on the top right.

custom

Protection
Exclude Metadata
Exclude specified custom properties
Remove Metadata
Delete custom properties (Office)
Interactive Protect
Delete custom properties (Office)
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Click the parameter in the results list and the relevant category and sub-category is
displayed in the Workshare Configuration Manager.

SETTING PARAMETERS

Most parameters in the Workshare Configuration Manager are set by selecting or
deselecting a checkbox. There are also some that require you to enter a value in a text
box.

To specify parameters:

1. In the Workshare Configuration Manager, select a category and then a sub-
category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting
an option from a dropdown list or entering a value in a text box.

Default document open location

a8 Default email attachment format | Portable Document Format (.pdf)

Default Redline save location

Default rendering set

[T Display document description as well as document ID
Display document selection dialog on startup
£ Display Redline in page layout view @

Display source document labels

The '9 icon to the right of a parameter indicates that the parameter value has
been changed.

Note: When parameters have been locked by your administrator, the parameter
will be disabled and a lock symbol will appear to the left of the parameter. You
cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as
required.
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4. Click Apply to save your settings. A confirmation message is displayed once the
settings have been saved.

Options applied - restart Office applications

The options have been successfully applied for this user.

Please restart all running Microsoft Office applications
to ensure that your changes take effect.

5. Click OK and restart all Microsoft Office applications.

Note: The different sub-categories and their parameters are described in the
Workshare Configuration Options guide.
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APPENDIX A. CLEAN AND LIGHTSPEED
CLEAN

This appendix describes the differences between the Lightspeed clean and the regular
clean performed by Workshare Protect. It includes the following sections:

Types of Cleaning, page 109, introduces Lightspeed cleaning and regular cleaning.

Features Cleaned, page 109, describes the features in Microsoft Word, Excel and
PowerPoint files that are cleaned.

Cleaning PDF Files, page 115, describes how Workshare Protect cleans PDF files.
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TYPES OF CLEANING

Lightspeed cleaning is a secure white-out technology that overwrites hidden data to
prevent leaks. Lightspeed cleaning is much faster than regular cleaning because it does
not rely on Microsoft Office for cleaning the document and uses exclusive binary
reading and writing technology. Lightspeed cleaning maintains the original structure of
the document but may either remove hidden data or redact it (replace it with spaces).
Thus regular cleaning actually removes the hidden data element from the document
whereas Lightspeed cleaning may have different effects. There are some subtle
differences in how each technology cleans the document but both ensure the document
is safe.

FEATURES CLEANED

The following tables detail the features of Microsoft Word, Excel and PowerPoint
documents that are cleaned by Workshare Protect when a Clean or a Lightspeed
Clean is performed on the document. The tables also briefly explain the effect of the
clean or Lightspeed clean. The effect of these actions varies according to the format of
the document:

DOC/XLS/PPT Word 97-2003 Document/Excel 97-2003 Workbook/PowerPoint
97-2003 Presentation

DOCX/XLSX/PPTX  Office Open XML Format (no macros)
DOCM/XLSM/PPTM Office Open XML Format (macros allowed)

Microsoft Word Documents

Feature Clean Lightspeed Clean
DOC Format DOCX/DOC DOC Format DOCX/DOC
M Format M Format
Track \ \ \ \/
Changes Deleted Deleted Deleted, but where Deleted

track change deletes
text, the text is
turned into hidden
spaces (revealed if
turn on “show
hidden text”)

Comments v N v \
Deleted Deleted Deleted Deleted
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Feature Clean Lightspeed Clean
DOC Format DOCX/DOC DOC Format DOCX/DOC
M Format M Format
Small Text v \ \ \
Deleted Deleted Deleted, but turned Deleted

into hidden spaces
(revealed if turn on
“show hidden text”)

White Text \ \ \ v

Deleted Deleted Deleted, but turned Deleted
into hidden spaces
(revealed if turn on
“show hidden text”)

Hidden Text N N \ \

Deleted Deleted Deleted, but turned Deleted
into hidden spaces
(revealed if turn on
“show hidden text”)

Versions N NA v NA
Deleted Deleted

Authors N \ \/ v
Deleted Deleted Deleted Deleted

AutoVersion v NA \ NA
Cleared Cleared

Custom N \ V l

Properties Deleted Deleted Deleted Deleted

(in Custom

tab)

Document N X \/ v

Variables Deleted Name and value Deleted

turned into spaces
but the document
variable still exists

Macros V \ \ \
Deleted Deleted Deleted Deleted

Routing Slip V NA \ NA
Deleted Deleted

Reviewers \ \ \ \

Deleted Deleted Deleted Deleted
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Footnotes

Fields

Hyperlinks

Document
Statistics (in
Statistics
tab)

Built-In
Properties —
Standard
Properties
(in Summary
and
Contents
tabs)

Smart Tags

Template

Clean
DOC Format DOCX/DOC
M Format
v v
Deleted Deleted
v v
Field code is | Field code is
deleted and deleted and
the result the result

turned to text

\/

Hyperlink
removed and
the result
turned to text

N
Deleted

N
Deleted

N
Deleted

\/

Removes
reference to
template and
shows only

“Normal”

turned to text

\/

Hyperlink
removed and
the result
turned to text

X

N
Deleted

N
Deleted

\/

Removes
reference to
template and
shows only

“Normal”
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Lightspeed Clean

DOC Format

\/

Turned into hidden
spaces (revealed if
turn on “show
hidden text”)

\/

Field code turned to
blank spaces and
the result left. When
update performed,
result becomes
empty

\/

Hyperlink turned to
blank spaces and
the result left. When
update performed,
result is error...

\/

Deleted “Last Saved
By” and other fields
reset.

N
Deleted “Title”

N
Deleted

\/

Removes reference
to template

DOCX/DOC
M Format

\
Deleted

\/

Field code is
deleted and
the result
turned to text

\/

Hyperlink
removed and
the result
turned to text

\/

Deleted “Last
Saved By”
and other

fields reset.

\
Deleted

\/
Deleted

\/

Removes
reference to
template and
shows only
“Normal”



Feature

Headers

Footers

Endnotes

Text Within
Text Box

SmartArt

DOC Format

Clean

DOCX/DOC
M Format

X \

Checks
headers in
same way as
body text

X \

Checks
footers in
same way as
body text

v v
Deleted Deleted

Microsoft Excel Workbooks

Feature

Track
Changes

Comments

Small Text
White Text

Clean
XLS Format XLSX/XLSM
Format
v v
v v
X \
X \
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Lightspeed Clean

DOC Format

X

\/

Deleted text of
endnote but leaves
separator

\/

Deleted text from
textbox

N
Deleted

DOCX/DOC
M Format

\/

Checks
headers in
same way as
body text

\/

Checks
footers in
same way as
body text
\/

Deleted

\
Deleted text
from textbox

\/

Deleted text
from
SmartArt

Lightspeed Clean

XLS Format

\/

\/

Comment turned to

blank spaces but

placeholder remains

X
X

XLSX/XLSM
Format

\/

\/



Feature

Authors

Custom
Properties
(in Custom
tab)

Macros
Routing Slip
Hyperlinks

Document
Statistics (in
Statistics
tab)

Built-In
Properties —
Standard
Properties
(in Summary
and
Contents
tabs)

Smart Tags
Headers
Footers

Text Within
Text Box

SmartArt

Clean
XLS Format XLSX/XLSM
Format

v v

v v

X X

\ NA
X X

\ X

v v

X X

v v

v v

X X
NA X
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Lightspeed Clean

XLS Format

\/
\/

< |2 2 =2

X | 2 2 X

NA

XLSX/XLSM
Format

\/
\/

NA

X | 2 2 X
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Microsoft PowerPoint Presentations

Feature Clean Lightspeed Clean
PPT Format PPTX/PPTM PPT Format PPTX/PPTM
Format Format
Comments V \ \ \

Comment turned to
blank spaces but
placeholder remains

Small Text X
White Text
Authors

Custom
Properties
(in Custom
tab)

Macros X

2 |2 X | X
2 |2 X X
2 |2 X X

X
\
\

b
b
< | =
2| 2

Hyperlinks

Document X \ \
Statistics (in

Statistics

tab)

Built-In \ \ \ \
Properties —

Standard

Properties

(in Summary

and

Contents

tabs)

Smart Tags
Template
Headers
Footers

Text Within
Text Box

SmartArt NA NA

Speaker \ \ \ \
Notes

X | X X | X | X
X X X | X | X
X X X | X | X
X 2 2 X | X

X
X
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Feature Clean Lightspeed Clean
PPT Format PPTX/PPTM PPT Format PPTX/PPTM
Format Format
Hidden V v v v
Slides

CLEANING PDF FILES

Workshare Protect does not distinguish between clean and Lightspeed clean when
cleaning PDF files and whichever type of cleaning is selected, Workshare Protect will
clean PDF files in the same way.

Feature PDF PDF/A
Attachments \ \
Bookmarks \ \
Markup \ \
Properties \ v

Cleaning Properties from PDF/A
invalidates the PDF/A status

115



S NVEIEN  CONFIGURING WORKSHARE DESKTOP APP

APPENDIX B. CONFIGURING
WORKSHARE DESKTOP APP

This appendix describes how to configure the Workshare desktop application (the
desktop app). This is an application that syncs content between Workshare and your
PC so you can access your files and continue collaborating from your desktop while
offline.
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CONFIGURING THE WORKSHARE DESKTOP
APP

You can configure application settings for the desktop app, such as the location of the
sync folder or general account settings.

To configure the desktop app:

1. From the File menu in the desktop app, click Preferences (or click Preferences
in the system tray icon menu). The following dialog is displayed.

) Account E=soy <=
& B K O o

Account General Network SyncSettings Notifications

User Login: helen.sagal@workshare.com

Account:  Workshare Ltd
Server: https://my.workshare.com

Version:  Workshare 2.1.0.619
Check for Updates

The Account page provides information about your account. You can see your
registered Workshare email address that you use to log in to Workshare as well
as the address to the Workshare server. Additionally, you have version
information about the Workshare desktop app.

2. From here, you can:
= Click Sign out to log out of the desktop app.

= Click Check for Updates to see if there are any updates to your version of
the desktop app.
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3. Click General.

5 General — *

@ u ®«® o ol

Account  General MNetwerk Sync Settings  Motifications

[] Launch Warkshare when I login
Display DMS Open dialog when adding files (Requires Workshare 9 with a DMS integration)

Control how Workshare updates:
._#.utmnaﬁm]ly download and install updates '_J

4. In the General page, select the Launch Workshare when | login checkbox and
the Workshare desktop application will start when your computer is started.

5. Select the Display DMS Open dialog when adding files... checkbox if your
installation includes a DMS integration and you want the DMS Open dialog to
display when adding files from the desktop app. With this option selected, when
you add files to Workshare from the desktop app, you will be able to select files
from your DMS.

6. To control how Workshare updates, select from the dropdown:

= Automatically download and install updates: Updates to the desktop app
will be downloaded and installed automatically as they become available.

= Notify me when updates are ready to install: you will be notified when
updates to the desktop app are available.
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7. Select Network.

e =
@ b & O -

Account General Network SyncSettings Notifications

Bandwidth: | Change Settings.... ]

Proxies: [ Change Settings... ]
Network Status Connected

The Network page enables you to limit bandwidth settings and change the
settings of your proxy server.

8. In the Bandwidth field, click Change Settings.

r r —T
(=) Bandwidth Q—— [
Download rate: [¥] Don't limit
Limit to: o | KBfS
i Save I [ Cancel ]

9. If you want to limit the bandwidth available to data downloaded to the desktop
app, deselect the Don’t limit checkbox and specify the limit in the Limit to field.

10. Click Save.
11. In the Proxies field, click Change Settings.
rL:_] Proxy M

Proxy Settings: () No Proxy

@ Auto-detect
) Manual:
Force Proxy:
Proxy Type: |HTTP ¥

Server:

Port:

E Save ][ Cancel
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12. When working with a proxy server, select Auto-detect and Workshare will use
your computer’s system settings to connect to the network, or select Manual and
enter your proxy server details manually.

13. When manually specifying proxy server settings, you can select Force Proxy
so that the desktop app traffic MUST go via your proxy server and if the proxy
server is not available then the desktop app will be offline.

14. Select the type of your proxy server (HTTP, HTTP Caching or Socks5) and
enter the server address and port number.

15. Click Save.
16. Select Sync Settings.

= Sync Settings . x

® b & © 9«

Account  General Metwork Sync Settings  Motifications

Workshare sync location:

|C:ﬂJsers;‘1’1eIensMorksharE | Browse

[+ show sync conflict resalution messages

17. If required, change the location of the Workshare sync folder by clicking the
browse button and selecting a different location. By default, this folder is named
and located as follows: C:\Users\[user name]\Workshare.

Any files or folders put in this folder will be copied into Workshare online.

18. Select the Show sync conflict resolution messages checkbox if you want
confirmation messages to display when resolving sync conflicts.
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19. Select Notifications.

- Notifcation =
@ L @ © «
Account General Network SyncSettings Notifications

Notify me when: By email By desktop alerts

Someone first accesses a folder

A new file is added to a folder

There is a new version of a file

A comment is posted

When someone shares files or folders with me

QEEE
FEERE

20. If required, change the notification settings. By default, users receive
notifications by email and via desktop popup alerts in the following
circumstances:

o When a user first accesses a folder you have shared with them
= When a new file is added to a shared folder

= When there is a new version of a file

= When a comment is posted

o When someone shares a file or folder with you
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